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This file is a compilation of APRS+SA related information that I 
extracted from the following sources: messages to the APRSPLUS 
reflector, a file called Current Version.txt that is included in 
the current version of APRSPLUSxxxxx.zip, and some of my own 
experience and knowledge using Automatic Packet Reporting System, 
A.P.R.S., software and some associated hardeware. Some of the 
information is edited by me to make it more comprehensible, to me. 
Some of the information means nothing to me, but may, later. 
 
The original messages concern the development and use of APRS+SA and 
APRS related software developed by Brent Hildebrand, Bob Bruninga, 
and others. The relevance, value and accuracy of this information is 
for you to determine. No warranty, by anyone, is given or implied 
with any of the APRS+SA and APRS related information contained herein. 
 
The information contained in this document file may not apply to 
the particular version of APRS+SA you are using. 
 
APRS+SA, APRSPLUS, and APRS+ should be considered the same program, in 
this document, unless the reader has some reason to believe otherwise 
from the context of the particular subject text. 
 
If you do not know how to use the find and search functions of your 
browser and file viewer, you may be overwhelmed by this expanding mass 
of APRS+SA related techno-poop. Relevent information to the topic of 
interest may be found in more than one place. 
 
The content may be changed, as I am moved, to reflect changes in the 
software, applications and my understanding of any and all topics 
covered. 
 
Do not e-mail me questions about content. Chances are, I know less 
than you. 
 
Do E-MAIL me , WITH DETAILS, if you KNOW the correct theory, procedure, 
application, jargon, etc., of that which I have written, incorrectly. 
 
The information presented has no specific order. I have tried to group 
information relative to a general or specific subject, as perceived at 
the time of addition/ editing. Relative to any particular subject, I 
have made an attempt to present the most current and/ or relevant 
information first. 
 
BOUQUETS AND BRICKBATS 
 
I will accept any and all deserved praise, DETAILED and CONSTRUCTIVE 
suggestions, and voluntary cash contributions to cover my various 
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costs of producing and maintaining this budding tome. 
 
If you wanna throw "bricks" at something that's "free"; don't. 
 
 
COPYRIGHT 
 
All rights to original content is reserved to manistique.org. 
 
 
LINKS 
 
Links to this site are encouraged and appreciated. 
 
 
DISCLAIMERS... Please, read them. 
 
You have the responsibility to read and use this information at your 
own risk, as a socially responsible individual, within the generally 
accepted boundaries of civilized human behavior. 
 
Disclaimers, elaborated: 
 
By reading or using, in any fashion, the contents of this file, the 
reader agrees to knowledge the following, and will testify to such, 
as may be necessary: 
 
I, the author of this information file, make no claim to any qualified 
expertise or knowledge relative to any and all subjects covered. 
 
I, the author of this information file, do not know that all the 
information included, is true or correct. 
 
I, the author of this information file, do not know if some 
information content will be used, by others, in a harmful manner. 
 
I, the author of this information file, have no knowledge of a 
reader's intentions, or the suitability of the information contained, 
relative to a reader's intentions, and I have no knowledge of the 
effects of a reader's intentions. 
 
The reader understands that if, as a consequence of reading, revealing 
or using any of the information found in this file, the reader causes, 
in any direct or indirect fashion, any public or private damage, 
injury, pain, or suffering, of any sort, it is all the consequence of 
reader's conscious and voluntary action. 
 
The reader knows that no influence was exerted by the various authors 
of the following information to encourage the reader to commit, in any 
fashion, any action that is illegal, socially or personally 
unacceptable, or detrimental to the health, property and well being of 
everyone, including the reader. 
 
 
 
                          APRS+SA TOPICS 
 
           As Compiled, Edited and Embellished by WA4HEI 
 
CREDITS 
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Most of the credit for the content of this document goes to APRS+SA 
author KH2Z, Brent Hildebrand, and various users of the APRS+SA 
software that donated a piece of their lives to document some facet of the 
program. Their knowledge, shared via the magic of the Internet, made it 
possible for WA4HEI to create this document to help current and 
future users to derive greater use of, and enjoyment from, APRS+SA. 
 
 
SOURCES OF SOFTWARE 
 
APRS+SA software 
ftp://ftp.tapr.org/aprssig/winstuff/aprsplus/ 
 
APRS+SA home page 
http://www.tapr.org/~kh2z/aprsplus/ 
 
SV2AGW Packet Engine software 
http://www.elcom.gr/sv2agw/ 
 
 
SOURCES OF HELP 
 
APRS+SA documentation source 
http://www.qsl.net/ve5dgd/aprs/html/Site_Welcome.html 
 
APRS+SA documentation and links 
http://members.aol.com/wa8lmf2/APRSplusInstructions.pdf 
 
APRS+SA and AGWPE documentation and setup information 
http://www.qsl.net/soundcardpacket/ 
 
 
APRSPLUS REFLECTOR - AKA: NEWSGROUP or SIG 
 
For help, information, etc., subscribe, unsubscribe; send a message 
 
TO:  majordomo@k8sn.org 
 
leave the subject blank 
 
in the message body, put:  help 
 
 
APRS+SA Yahoo discussion group with posts archives 
http://groups.yahoo.com/group/aprsplus/ 
 
 
 
APRS PROTOCOL SPECIFICATIONS 
 
http://www.tapr.org/tapr/html/Faprswg.html 
 
 
 
WARNING! WARNING!   
 
APRSplus ONLY works with the "classic" Delorme Street Atlas Versions 4 
through 9.   
 
It WILL NOT work with ANY of the products based on the new user interface 
used by Street Atlas Road Warrior, Street Atlas "Deluxe", Street Atlas 
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2002, TopoUSA or 3-D TopoQuads. 
 
Many of APRSPLUS features require case sensitive commands or dialog in 
specific. syntax. If a particular feature "doesn't work", check the 
"dialog" or "command" case and syntax, before you report a bug to the 
author. 
 
 
 
APRSPLUS SETUP - QUICK START INSTRUCTIONS 
 
Running APRS+SA for the first time: 
The minimal settings required for initial configure APRS+SA on a Single 
Port TNC 
 
1) Unzip the APRS+SA file to its own directory 
2) Run Setup.exe 
3) Start APRS+SA by executing APRSPLUS.EXE - you will get a notification 
   that you are running an unregistered copy of APRS+SA. 
4) Click the Setup menu, select Main. 
5) Enter your Callsign 
6) Enter you Latitude - use decimal degrees for quick start 
7) Enter your Longitude - use decimal degrees for quick start 
   Put a negative sign (-) in front of the longitude value. 
8) Select a TNC Configuration File 
9) Check your Unproto path via, default is WIDE,WIDE.  Some parts of the 
   country use WIDE2-2. 
10) Configure Port 1, the TNC port. 
   a) Set Baud Rate. 
   b) Click the Port, and select the appropriate Com Port to Open the serial 
      port. 
 
You should see configuration data on the TNC page of the main program 
window. 
 
You can close the Setup window and reopen it at any time, if you wish. 
 
At this point, if your station is on an active RF network, and radio and 
TNC are on, you should begin to see data coming in on the TNC. 
 
Start Street Atlas. Then from the APRS+SA main window, press the keys, 
Ctrl-2. This will draw the position of all known station. 
 
If you are using Icons - you can not pan or zoom the map from within SA. 
Also, Icons are geared to just a single copy of SA. You will need 2 serial 
ports, one for SA and one for APRS+SA is you want to run the programs 
independently. 
 
You can run 2 instances of SA, and preserve one instance for normal SA 
function. It would require an additional serial port for GPS input. 
To preserve an Instance of SA, check the "Preserve One Instance of SA" 
option on the Program tab of Setup. There is a "Flash" button so you 
can easily identify which instance is being preserved. If you have this 
option checked and only one instance of SA is running, then APRS+SA will 
not generate any maps. 
 
 
 
UPDATE INSTALLATION 
 
The aprs+sa updates are released betas, but not a full release. They 
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should be considered experimental; so beware. 
 
Each update usually is announced on the APRSPLUS reflector with 
appropriate caveats. They all lead up to an official release version. 
 
Here is how you do the updates in general (not the full release update, 
but all the 200Q, R, S,T,U,V stuff:) 
 
Close APRS+SA 
 
The example is based on updating to 200v 
 
1. Download the file GPS200V.zip 
2. Extract the *.w3 and *.apl files to your main aprs+sa directory 
   (Don't worry, they don't overwrite anything) 
3. Extract zones.txt and codes.txt to your aprs+sa\nws directory 
4. Point your file manager (like Windows Explorer or Power Desk) to your 
   main aprs+sa directory. 
5. Double click on the program "setup.exe" in 
   that directory. 
6. It executes and when successful will show a little 
   box saying 200V installed. 
 
Restart the program, and you will see 200V as the version when you do the 
"about" command. 
 
 
Special Notes on how to go backward in revisions: 
 
a. In your main aprs+sa directory there will be a pair of files that make 
   up the "update". Example: GPS200V.w3 and GPS200V.apl. Your prior version 
   is still in this same directory, assuming you have neither deleted nor 
   moved it. So you might see files like GPS199.w3 and GPS 199.apl. 
 
b. How to go back from 200V to 199: 
 
 1. Move GPS200V.w3 and GPS200V.apl to a temporary directory, or simply 
    delete them. 
 2. GPS199.w3 and GPS199.apl should still be in your main directory. If 
    not, put them there. 
 3. Re-run "setup.exe" as noted above and it will "install" 199 for ya. 
 
The install program always installs the latest version of code it finds. 
So if you have gps197, gps198, gps 199, gps200s and gps200v all in the 
main aprs+sa directory, and you then execute "setup.exe" from that 
directory, it will install ONLY gps200v... 
 
It could be prudent to keep several versions of older "uninstalled" code 
in the main directory, as well as the updated code that you are actually 
using. 
 
How do you tell the difference between an update and a "patch"? 
 
An update will have extracted file names like this: GPS200x.w3 and *.apl. 
A patch will be a file that looks like this: NWS.P199 
 
Patches are loaded automatically if they reside in the main aprs+sa 
directory. Updates have to be "installed" using the "setup.exe" program. 
Patches auto load at program start, or can be patched in live with the File 
> Load Patches command from the main menu. Patches are not "installed". 
They are loaded each time the program is run. Updates are "installed" 
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permanently and are only affected if you re-run "setup.exe" with a 
different *.apl and *.w3 in place. 
 
To list patched internal functions: File > List Loaded Patched Functions. 
Patched functions will appear in the status bar. 
 
Suggestion: 
 
Download ALL versions to a directory named "aprs+sa patches". Then 
extract from this directory to the main aprs+sa directory. This way you 
have a repository of every update, patch or whatever you may want to go 
back to, or simply refer to. 
 
 
 
CONFIGURATION SETUP.REG FILES AND *.REG 
 
You can have multiple Setup files, but only the most recently used 
configuration is automatically loaded. After exiting the program, if you 
restart APRS+, it restarts with the configuration file that was in use, 
when last exited. Once started, you can change the configuration to any 
.reg file you may have saved, by Setup > Internet > File > Open > the .reg 
file of choice. The ability to save configuration data is available 
to registered users, only, as Setup > Internet > File > Save or Save As > 
the .reg file of choice. 
 
 
 
COMMAND LINE SWITCHES 
 
APRS+SA has no command line switches. 
 
 
 
MEMORY ISSUES 
 
All APRS program have to deal with memory. Any version that connects to 
the Internet has to deal with the 3-4 packets per second, and all the data 
they contain. 
 
The first and primary memory setting in APRS+SA, is the "Work Space Size" 
at the top of the Program tab of Setup. If some operation exceeds the 
memory requirement as set my the Work Space Size, you will get a "WS FULL" 
error announcement. 
 
To control data in the Work Space, APRS+SA provide the "Data" page of 
Setup to allow you some control over how data is retained. The left 
column of the Data page is the number of Hours you want to retain data. 
If you set Messages to 24 hours, and set the check box next to it, and 
check the "Enable Automatic Data Deletion" at the top of the column, you 
will only retain messages that are 24 hours old or less. 
 
The right column of the Data page has several options. The first is the 
total number of Position reports, Posits, to retain at anyone time. 
Default is 4000. A ballpark estimate of this setting is to take the Work 
Space Size and divide by 2000. If the Work Space is set to 10Mb, the 
default, this yields a number of 5000. Setting it to 4000 gives you a 
margin to work with. 
 
The next setting is the number of Posits to retain for stations you are 
not actively tracking, default 10. With 10, you get a feel if a station 
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is moving or not and a sense of their direction of travel. 
 
All calculations and data manipulation takes place in the APRS+SA Work 
Space. APRS+SA does use memory beyond the Work Space for all the display 
objects. If these displays become large, you may exceed the amount of 
physical memory, and begin causing data to be swapped to disk in virtual 
memory. This can cause overall slow performance of the program and the 
computer. 
 
I kept data on line for more then a year, saving only 1 Posit for 
untracked stations. I had over 9600 stations and objects! Some data was 
almost a year old when I cleared the list. 
 
 
Another Approach 
 
First: 
 
With "APRS+SA set for 25000000 workspace size. I have NEVER gotten an 
"Out of Memory" or "Out of Workspace" warning." 
 
Second: 
 
Look at Setup > Data   there a quite a few changes to make here in order 
to maximize memory efficiency: 
 
1. Enable auto data deletion 
2. Put a check in every box and think about just how long the data in 
   each category is of any real use. 
 
Positions: reduce from 12 to 6 hours or less. 
Bulletins: reduce to a couple or 3 hours, or less 
Traffic: reduce to less hours...who cares who sent what to whom more than 
an hour ago? 
Status: reduce to less hrs unless you have a special need Weather: 
If you log RF to disk  then this can be reduced dramatically. 
(Store weather trends, RF only) 
Objects: same as status 
Telemetry: 1 hr unless you use it 
Inbox: Leave it at 24 unless you are certain you will check all messages 
to you within 24 hours. 
Igate: If an Igate is unknown for 3 hours, its not much use anyway. 
 
Now...here is where you can REALLY SAVE MEMORY and INCREASE PROGRAM SPEED: 
 
Delete Data By Range....check this: and set to 750 miles or 500 miles. 
 
Click on the "Do It" button. 
 
Go the main program, click on Commands, drop down to Range Filter 
and set it for a limit that reflects your actual use and needs. I have 
mine set to 200 miles. 
 
Go back to Setup > Main and make sure the checkbox for Range Filter is 
checked. The value in the box should be whatever you set your Range Filter 
to in the last step (Commands > Range Filter) 
 
You will still see all the national NWS warnings, they don't get filtered. 
You will still be able to message everyone on the internet. 
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LOW MEMORY MESSAGES 
 
Before asking about low memory messages, consider the following: 
 
What is generating the message? In other words, is the message a 
APRS+SA message or a Windows message? If the message is a Windows 
message, is it low memory or low resources?  Windows Me is based on Win 
98, which was based on Win 95. They all may have a resource restriction 
which might prevent APRS+SA and SA from being run on the same computer with 
any other applications running. You might post the exact wording of the 
warning, its source, and what you have running on your computer at the time. 
 
Check WxData subdirectory of your APRS+SA directory.  There is were the 
WX data it stored.  What is the size of your data file? 
 
> 9,303 KB 
 
That would be more then 129000 weather data points!  IF you have the ram, 
put your workspace size up to 50000000. You don't need to reboot your 
computer, just restart the program. 
 
 
 
TRANSFERING OLD FILES TO A NEW VERSION 
 
To anyone installing the latest beta, you should do it as a clean 
installation.  Do not copy over an old version. There are a list of 
files you MAY want to copy over from an old installation. They are: 
 
APRSPLUS.DAT, APRSPLUS.REG, SETUP.REG, *.REG (different user setup 
files), TACTICAL.TXT, and PATHS.CSV. and any *.MOP files you might have. 
 
You might save, to a "safe" directory, the following from your previous 
version, in addition to those above: 
 
APRSPLUS.INI, SETTINGS.INI, SMARTVALUES.DAT, MESSAGE.TXT, PATHS.PATH, 
AUTOANSWER.TXT. 
 
NB! Any use of old files is subject to possible problems that may result 
from changes in file format as the program evolves. 
 
 
 
DEAD TNC? 
 
Several manual command sequences may be of use to a TNC user with a 
TNC that appears "frozen", i.e.. refuses to respond to commands. 
 
NOTE: No <Enter> key strokes are used in the escape keystroke sequences 
 
Switch from Converse mode to Command mode 
<Ctrl>C 
 
Switch from "other user modes" to Command mode 
<Ctrl>C 
X 
 
Switch from host mode to native mode 
<ALT>192 (use numeric keypad, not the keyboard) 
Q 
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<ALT>192 (use numeric keypad, not the keyboard) 
 
Switch from KISS mode to native mode 
 
<ALT>192 (use numeric keypad, not the keyboard) 
<ALT>255                 " 
<ALT>192                 " 
 
Rephrased: 
 
To exit KISS from keyboard commands: 
 
1. Press and HOLD ALT key, then type the numbers 192 from the numerical 
keypad (not the keyboard); then release the ALT Key. 
 
2. Next, Press and HOLD ALT key type the numbers 255 from the keypad. 
Release ALT key. 
 
3. Press and HOLD ALT key and enter the numbers 192 from the keypad. 
Release Alt key. 
 
You should then be out of KISS mode. 
 
 
 
RESTORE.TNC, THE TNC RESTORE FILE 
 
RESTORE.TNC is the file in which the configuration parameters for a 
tnc used with APRS+ is restored to a user's preferred configuration, 
automatically, upon quitting APRS+. 
 
Create or edit the RESTORE.TNC file. This file is sent to the TNC when 
APRS+SA closes the TNC serial port. 
 
 
 
HOVER TEXT 
 
Expanded "hover" text. Move cursor over callsign on many tabs will show 
most recent position in Lat/Long, Grid Square, and UTM.  And show age of 
position. This is now available on Position and Position 2 tabs. 
 
 
 
TOOLTIPS 
 
Tooltips and hover text are likely to be found anywhere, as the program 
evolves. Some of the places tooltips may be found are: data lines for 
Status, Weather, Traffic, Inbox, Object, Telemetry, and IGate tabs 
showing range, bearing and time since last position report 
 
 
 
UNPROTO PATHS 
 
Commands menu, select Unproto Paths or Control+Shift+U 
 
A slot has been added to the Unproto path window to support paths 
manually entered in the Unproto Via slot on the Main Setup window. 
This path will be used if no default path has been set. Default path 
is set with the Set buttons on the Unproto path window, or with the 
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Via dropdown on the Main page of Setup. 
 
 
 
RF GATE UNPROTO PATHS 
 
Rf Gate operators should set a vhf and hf Unproto path, for rf packets 
gated from the tnc vhf radio port to the tnc hf radio port. 
 
Paths for dual port TNCs should contain the paths for both ports, in 
whatever format the particular tnc was designed to support. 
 
Kantronics' KAM Example: 
 
GATE,WIDE/RELAY,WIDE-2. 
 
Here KAM tnc port 1's path is GATE,WIDE, 
and  KAM tnc port 2's path is RELAY,WIDE-2. 
 
KAM tnc Unproto Path port of 0 equals both port 1 and port 2. 
 
Presuming you have checked the DUAL PORT TNC option on the SETUP, MAIN 
screen, then reports will be sent to the ports indicated depending on the 
path you have selected. I.e., If you do COMMANDS, UNPROTO PATHS you can 
set paths and select which one will actually be sent. The PORT 0 sends 
to both VHF and HF sides, PORT 1 send to HF only, PORT2 sends to VHF only. 
In other words, you can have paths set for both HF and VHF, but the PORT 
setting determines which one will actually be sent. 
 
For Dual-Port TNCs, the port assigned to the Path ID in the 
Commands > Unproto Path list will be the IGate outbound port for 
internet data also. This can be used to ensure that the IGate does not 
transmit to HF. Also, the IGate Local List will be determined by the 
outbound port as well (for Dual Port TNCs). 
 
Running APRS+SA Kantronics KamPlus version 8.2, set the commands of : 
 
NUMNODES 1 
INIT term 
MYG gate 
KNXC on 
MAXUSERS 2 
UIGATE ON/OFF 
 
And in the APRS+SA software "setup"  on the "Main" tab selected the "Dual 
Port Selected" 
 
 
 
CHANNEL FILLER UNPROTO PATH 
 
Channel Filler 
 
If your RF network is quiet, you can use the Channel Filler function which 
will gate random packets from the Internet to RF at the specified rate of 
1 each X seconds; where X is a number greater than or equal to 30. If the 
RF side become active, the Channel Filler will back off automatically. The 
idea is to add some fill to the an RF network will little activity. 
 
Setup > Internet > Channel Filler has a dialog box for a filler path ID 
number that matches the number of the particular path desired in the 
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Unproto path list, under Commands>Unproto Paths. If there is no match, 
the default path ID number is used. 
 
 
 
SUGGESTED TRACKER PATHS 
 
Various digi sysops and home station operators have crippled the APRS 
rf network, in their neighborhoods, by configuring their equipment in 
a manner hostile to itinerant travellers; by creating a local network 
that ignores, among other things, the generic RELAY digi alias. The 
following suggestions are probably as good as any, for those passing 
through foreign territory that wish to make the best of generic paths, 
without creating undue QRM by playing DXer. 
 
In urban areas, it should not be necessary to use more than 2 digi hops, 
as in RELAY,WIDE or WIDE,WIDE, depending on the prevalence of stations 
and digis configured to support RELAY. It is difficult, obviously, for 
the casual APRS traveller to determine what paths are supported and what 
is not. You must choose to either support local anarchism or not. 
 
RELAY,WIDE2-2 (should covers all local stuff) 
RELAY,WIDE,WIDE  (covers areas where WIDEn-n is not supported) 
WIDE3-3  (covers areas where there are no RELAY stations) 
WIDE,WIDE (covers all the rest) 
 
 
 
PHG DISPLAY SETTINGS 
 
To show the circle for Power-Height-Gain if a station transmits it. 
 
Under Commands > Map Options (or cntrl-shift-M). The resulting free 
floating window has several tabs: the two last ones (Circles which 
determines the color and type of line and fill, and APRS which determines 
if range circles will be drawn around stations based on PHG values). 
 
 
 
SELECTING YOUR PHGD CODE VALUES 
 
Setup > Profile > PHGD box    e.g.:  6,2,9,1 
 
   PHG Code:    0   1   2   3    4    5    6     7     8     9  Units 
 
      Power:    0   1   4   9   16   25   36    49    64    81  Watts 
     Height:   10  20  40  80  160  320  640  1280  2560  5120  feet 
       Gain:    0   1   2   3    4    5    6     7     8     9  dB 
Directivity: omni  45  90 135  180  225  270   315   360 empty  degrees 
 
PHG0000 is not a valid string because the lowest increment of power is "1". 
A power of zero  in fact is not transmitting anything, so no one will ever 
see it. 
 
 
 
DEFAULT INTERNET PATH 
 
The Internet path is always used for an Internet or localhost connection. 
 
The default Internet path of "APS207 via TCPIP" cannot be changed. 
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The specific number depends on program version number. i.e.IE 207, in 
this current example. If a user prefers to use the grid square option 
to display his position, the default APS207 would be replaced with a 6 
character grid square designator. eg. "EN65UX via TCPIP". 
 
 
 
IGATE INBOUND PATHS; RF TO INTERNET 
 
All local rf packets, being transferred by an IGate, to the internet TCP 
data stream, use the non changeable, default internet path, represented 
at the top of the  Unproto list with the ID of I. 
 
 
 
IGATE OUTBOUND PATHS: INTERNET TO RF 
 
All packets being transmitted from an IGate, to rf, use the rf Unproto 
path set by the user from the Commands > Unproto List. 
 
For Dual-Port TNCs, the port assigned to the Path ID in the 
Commands > Unproto Path list will now be the IGate outbound port for 
internet data also. This can be used to ensure that the IGate does not 
transmit to HF. Also, the IGate Local List will be determined by the 
outbound port as well (for Dual Port TNCs). 
 
 
 
IGATE FILTERS 
 
Setup > Internet > selectable Hops and Time filters affect only internet 
to rf data flow. 
 
Setup > Lists > Gate by Callsign to gate (pass) packets from a given 
callsign, enter that callsign into list. You can use wildcards also, 
such as VA3DRV*. Enable list with check box. 
. 
Setup > Lists > Gate Object by Icon list, to gate objects by icon. 
 
Setup > Settings > IGate > TypeReject key. This allows IGate operator to 
exclude certain types of packets from being send into the APRS/IS. I would 
caution against using this option as I'm in general opposed to doing any 
filtering of the APRS/IS data except for duplicates. This should be used 
for very special cases. BH 
 
 
 
IGATE THIRD-PARTY TRAFFIC 
 
The "}" type, 3rd party packets are automatically excluded from the 
Internet feed. 
 
APRS provides a mechanism for formatting packets that are to be transported 
through third-party (i.e. non AX.25) networks, such as the Internet, an 
Ethernet LAN or a direct wire connection. 
 
In both cases, the "unused" digipeater callsigns (i.e. those digipeater 
callsigns after the asterisk) in the original Source Path Header are stripped 
out. The asterisk itself is also stripped out of the Source Path Header. 
Then two additional callsigns are inserted: 
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1) The Third-Party Network Identifier (e.g. TCPIP). This is a dummy 
   "callsign" that identifies the nature of the third-party network. 
2) The callsign of the receiving gateway station, followed by an asterisk. 
 
Third-party packets are those packets generated by an IGate to RF. After a 
packet emerges from a third-party network, the receiving gateway station 
modifies it (by inserting a } Third-Party Data Type Identifier and 
modifying the Source Path Header) before transmitting it on the local APRS 
network. 
 
 
 
IGATE POSITION DECODING AND DISPLAY PLOTTING FILTER 
 
If monitoring RF and the Internet at the same time, the internet side can 
cause the RF side to be dropped if you have the Data tab of Setup to limit 
the number of active position reports. There is a Key in the Internet 
section of Settings called InternetPositionCallsigns. You can enter the 
callsign(s) of the stations you want to monitor from the internet side. 
Those not in the list are not retained. And Empty key, is the same as "*", 
or all stations. This key can be used to greatly restrict what stations 
are decoded. 
 
Want to just map the stations you receive by rf but send all local 
rf stations to the internet server? 
 
You can stop decoding POSITION data from the Internet by assigning a value 
to InternetPositionCallsigns in the Internet section of Settings. Assign 
something like ZZZ would cause the program to stop decoding position 
packets if the callsign was not an exact match to ZZZ. 
 
 
 
IGATE PAGE COLUMNS 
 
3 columns: 
 
Totals, since last cleared: 
 
Number of Messages (MSG),  Local stations (LOC) and Fill 
packet (FILL) transmitted by the IGate. 
 
To clear, see Setup > Settings > IGate 
 
 
 
IGATE CONFIGIRATION AND INTERNET APRS SERVERS 
 
To activate the basic IGate function of APRS+ requires little more than 
establishing the internet connection: Setup > Internet > Connect, after 
an active APRS server is entered in the Server dialog box. 
 
The gating of rf to internet occurs automatically, as does the display 
of internet traffic on the various pages of APRS+. Numerous filters 
are available to limit the data displayed. The use of some are detailed 
elsewhere in this document. 
 
The choice of server and port can make a difference in the amount of data 
sent to your client, BUT there is no way the client can control the amount 
and type of server data sent to it. Relative to any particular server, you 
ask for data, you get all the data that particular server is configured to 
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pass. 
 
APRS data servers interconnect the various APRS clients, providing them with 
a constant flow of APRS data, in TCP/IP. An appropriate sever and port 
must be chosen and entered into the Setup > Internet > Server dialog box. 
Left double click the "Server" dialog box title to edit the file. 
 
 
NOTE: Any and all servers are liable to be "broken", or inoperative for 
      any number of reasons. Keep in mind, this is a hobby, with very 
      little cash donated to keep the hardware and services on line. 
 
; APRServe sites Updated 26 Oct 2002 by WA8LMF@aol.com 
; Comment Lines begin with a ; 
; "Dump" refers to cached recent past history. 
; This list formatted for direct use with APRSplus. 
; Copy/paste this list into the file APRServe.txt located in 
; the APRSplus\data directory 
; For use with WinAPRS, delete this comment area, 
; then in the remainder, find and replace colons 
; and semi-colons with the "TAB" character. 
; Standard APRSd port definitions at 
; http://www.ntstrans.com/~ntstate/ports.html 
; Direct IP addresses subject to change -- 
; recommended to use only when DNS (named) access fails. 
; APRSD servers can produce status report 
; Enter http://servername:14501  into your WEB browser 
; 
; Findu mapping is now      http://map.aprs.net/callsign 
;  or                       http://second.aprs.net:8000/callsign 
; www.aprs.net:23 ;RIP 
 
first.aprs.net:23 ;First APRS Net 
128.143.202.191:23 ;First APRS Net - direct IP 
first.aprs.net:10151 ;Florida server w/cache dump 
first.aprs.net:14579 ;Florida server LOCAL ONLY 
 
second.aprs.net:23 ; SoCal Second APRS Net 
134.173.254.38:23 ; Second APRS Net - direct IP 
second.aprs.net:10151 ; SoCal server w/ cache dump 
second.aprs.net:14579 ; Socal server LOCAL ONLY 
 
third.aprs.net:10151 ;Third APRS server w/8H dump 
third.aprs.net:10152 ;Third APRS server w/o dump 
third.aprs.net:14579 :Third Local Data Only 
 
;AHubEast (javAPRSSrvr) 
ahubeast.net:10152 ; Full APRS Feed 
ahubeast.net:10151 ; Full APRS Feed w/ 30 Min Dump 
ahubeast.net:1314  ; Full Feed - Read Only 
ahubeast.net:14579 ; Eastern USA Regional 
;  HTML Status Ports 
;http://www.ahubeast.net:14501 Main Port 
;http://www.ahubeast.net:14601 Regional Port 
;  WEB SITE 
;http://www.na4v.com 
 
;APRSWEST (javAPRSSrvr) 
aprswest.net:10152 ;Full APRS Feed - Main Port 
aprswest.net:10151 ;Full APRS Feed - with 30 min. Dump 
aprswest.net:1313 ;Link Port - Full Feed - Read Only 
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aprswest.net:1314 ;Full APRS Feed - Message Only 
aprswest.net:14579 ;APRSWESTR Western States Regional Port 
aprswest.net:10153 ;APRSWESTR Western States - with 30 min. Dump 
;  CWOP/Weather Server (No IGates Please) 
;  NOTE: REMed out to prevent accidental selection as IGate 
;  Delete the semi-colon to activate 
;aprswest.net:23 ;APRSWESTX CWOP/WX Primary Server 
;aprswest.net:10153 ;APRSWESTX CWOP/WX - with 30 min. Dump 
;ahubca.net:23 ;CAWXBAK CWOP/WX Secondary Server 
;  APRSWEST HTML Status Ports 
;http://aprswest.net:14501 Main Port 
;http://aprswest.net:14601 Regional Port 
;http://aprswest.net:14701 CWOP Port 
;  APRSWEST JAVA Display 
;http://java.kb7zva.com 
;  APRSWEST WEB SITE 
;http://kb7zva.com 
 
;Ahub California -- Website:  www.aprsca.net 
aprsca.net:2023 ;Worldwide 
aprsca.net:14579 ;California 
aprsca.net:10150 ; Special SATgate send-only with no RX stream 
 
;East Lansing, MI (Mich State Univ) 
elansing.aprs.net:10151 ;Full Internet Feed 
elansing.aprs.net:14579 ;Local Only 
 
;Fenton MI 
fenton.miaprs.net:10151 ;Full Internet Feed 
fenton.miaprs.net:10152 ;Full Internet Feed w/o cache dump 
fenton.miaprs.net:10151 ;Local RF Only 
65.170.9.12:10151; Full Internet Feed - Direct IP 
 
;Grand Rapids, MI Satgate Running: APRSd 2.1.5b9 
igate.miaprs.net:14601 ;status 
igate.miaprs.net:14679 ;Grand Rapids, MI Sat Data heard on local TNCs, 
tracking PCSAT and UO22 igate.miaprs.net:10251 ;Worldwide Sat data feed 
received and filtered from first.aprs.net igate.miaprs.net: ;10252   Same 
as 10251 without history 
 
aprsdcsp.antelope.net:10151 ;FULL - Rocky Mtn regional server in Casper WY 
aprsdcsp.antelope.net:10152 ;FULL w/o cache dump (current only) 
aprsdcsp.antelope.net:14579 ;Local 
 
;Tucson, AZ server 
packet.kvoa.com:10151 ;Full feed 
packet.kvoa.com:14580 ;Local (Tucson) feed 
 
;Northwestern US - Southwestern Canada -- Presumably normal aprsD ports 
linus.chemeketa.edu:10151 ;Salem, OR  aprsd-CCC 208.194.173.138:10151 
;Redmond, WA  aprsdRDM the.hams.net:10151 ;Portland4,OR aprsdPDX 
calgary.canaprs.net:10151 ;Calgary, Alberta aprsdYYC 206.186.216.155:10151 
;Winnipeg, Manitoba aprsdYWG 
 
jnos.org:10152 ;Redmond, WA aprsdRDM  WW messages and PNW local 
jnos.org:14579 ;Redmond, WA aprsdRMD  Local RF 
 
;Northern Europe 
ahubswe.net:2023 ;AHubSwe World-wide APRS Feed 
ahubswe.net:14579 ;AHubSwe Nordic APRS Feed 
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;Germany 
db0lj.dyndns.org:10153 ;European Traffic 
db0lj.dyndns.org:1313 ;German/Local Traffic 
 
;Australia APRS servers 
aprs.net.au:10151 ;1st VK Server - International feed w/ cache dump 
aprs.net.au:10152 ;1st VK Server - International feed w/o cache dump 
aprs.net.au:10153 ;1st VK Server - VK* & ZL* feed w/o cache dump 
second.aprs.net.au:10151 ;2nd VK Server - International feed w/ cache dump 
second.aprs.net.au:10152 ;2nd VK Server - International feed w/o cache 
dump second.aprs.net.au:10153 ;2nd VK Server - VK* & ZL* feed w/o cache 
dump 
 
 
rotate.aprs.net:10151 ;Rotating APRServe w/ dump 
rotate.aprs.net:23 ;Rotating APRServe w/o dump (current only) 
 
aprserve.dididahdahdidit.com:10151 ;Random aprsd server w/ cache dump 
aprserve.dididahdahdidit.com:10152 ;Random aprsd server w/o cache dump 
aprsdmsp.dididahdahdidit.com:10151 ;Andover, MN 
aprsdcho.dididahdahdidit.com:10151 ;Charlottesville, VA 
aprsdorl.dididahdahdidit.com:10151 ;Orlando, FL 
aprsdcle.dididahdahdidit.com:10151 ;Cleveland, OH 
aprsdlan.dididahdahdidit.com:10151 ;E Lansing, MI 
aprsdmtl.dididahdahdidit.com:10151 ;Montreal, QU 
aprsddfw.dididahdahdidit.com:10151 ;Denton, TX 
aprsdmia.dididahdahdidit.com:10151 ;Miami, FL (aprserver) 
aprsdmsn.dididahdahdidit.com:10151 ;Madison, WI 
aprsdsao.dididahdahdidit.com:10151 ;Sao Paulo, Brazil 
aprsdtus.dididahdahdidit.com:10151 ;Tucson, AZ 
aprsdden.dididahdahdidit.com:10151 ;Denver, CO 
aprsdatl.dididahdahdidit.com:14579 ;Atlanta, GA (local only) 
aprsdaly.dididahdahdidit.com:14579 ;Albany, NY (local only) 
 
 
 
FINDU 
 
As long as APRS data is gated to the internet, via an IGate, and through 
an active and properly configured APRS server, FindU will find you. 
FindU monitors the APRS traffic flow, continuously updating its data base 
to which the various inquiry software refer. 
 
 
 
GRIDSQUARE IN "TO" POSITION BEACON FORMAT 
 
Setup > Program > Transmit Grid-In-To Format; check box. 
 
On an APRS display, your call will be located at the center of the 
6 character gridsquare. The ambiguous location discourages visitors, etc., 
as it makes a precise location less convenient, yet it can be used to 
define a general presence. Format is considered by some to be obsolete, 
therefore it may not function with all software. 
 
 
 
DEAD RECKONING 
 
See the file, DeadReckoning.RTF. 
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To enable or disable dead reckoning: Commands > Map Options > APRS tab 
check or uncheck "Dead Reckoning On" box. 
 
Options on the APRS tab of the Map Options (MOP File) include "Enable Dead 
Reckoning" and "Zoom Included Dead Reckon". NOTE: A dead reckoned Position 
report is based on the last time the station was heard. A dead reckoned 
Object position is based on the included timestamp of the Object. 
 
Dead Reckoning 
 
1) What is it?  Given the last known position, course and speed, and how 
   long since the position report was receive, the current position is 
   estimated using great circle calculations. 
 
2) How is it displayed?  In APRS+SA there are two options for displaying 
   dead reckoning. 
 
   A.Map Options file. In the Map Options file, APRS tab, there is an 
     option to check to enable Dead Reckoning.  Doing so will cause a line 
     to be projected from the last known position to the estimated current 
     position. Also, checking the Zoom Dead Reckon option will cause the 
     estimated position to be included in the map zoom calculation. The 
     appearance of the projected line is controlled in the Settings window, 
     DeadReckoning section. 
     There are 4 file configuration keys: 
     [1] LineColor, values 0-4 for Black, Red, Blue, Green and Yellow. 
     [2] LineWidth, values 0-4. 
     [3] LineStyle, values 0-2 for Solid, Hatched and Highlighted. 
     [4] TimeLimit in hours beyond which Dead Reckoning is not calculated. 
     You can zoom in and out and pan as desired on the SA map. 
 
   B.Live Update. This method performs live updating of the estimated 
     position by drawing a line from the last known position to the current 
     estimate. This works similar to the drawing of APRS Icons on the SA 
     map. Enable Icons must be selected from the Maps toolbar, Maps Dropdown, 
     Views, Enable Icons. A system printer (any printer) must be installed 
     on your computer. Live update of the position will be estimated at the 
     rate of about once per second while the processor is not busy.  Live 
     update is performed on any station(s) that are in the Tracking List. 
     The line projected in live update is black, approximately 3 pixels wide 
     and is not user configurable at this time. You can not zoom in/out or 
     pan and have the projected line be in the correct location.  The SA map 
     must have been drawn by APRS+SA. 
 
 
 
GENERAL CLEARING AND DELETING DATA 
 
To clear all, use the Commands > Clear submenu options. 
Highlight line with right click. Left click and choose from menu. 
Variations of typical Windows mouse and keyboard manipulations. 
 
 
 
TIME FILTER 
 
Commands > Time Filter then select the time interval at which old positions 
will be removed from the map. The Time Filter will age position reports and 
remove them from the map. The Time Filter is non-destructive in that you can 
shorten or lengthen the time as desired. 
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SCROLLING ON/OFF 
 
Commands > Scrolling on/off controls the scrolling of the following pages: 
tnc, position, and likely? all dynamic displays. 
 
If you are working on the Positions page and go back to the TNC page, 
to find scrolling turned off, you can defeat the scrolling "pause" by 
going to Setup > Program and check box for "Turn Pause of after Menu 
Action on Position Page". 
 
With scrolling on, a scrolling page will scroll with new data, and with 
that action is a degree of screen flicker as all the data scrolls up 
a line. The flicker is more often when the data updates more frequently, 
depending on the amount of data filtering enabled. The duration of each 
flicker event, for each screen update event, is effected by the "speed" 
of the computer hardware used and the demands placed upon the video and 
CPU circuitry by the particular page scrolling. It takes a lot more 
computer resouces to deliver a flicker free Positions page, with all 
the icon images, than a flicker free TNC or TCP page. 
 
If you don't like the flicker when data scrolls, turn scrolling off. That 
is why you can turn off the scrolling. If you do not want to turn it off, 
go to a page that updates at a slower rate, or to a page that does not 
update, or to a scrolling page that requires minimal computer resources. 
There is more or less flicker depending upon your configuration and data 
activity. When the page is not visible, it does not take any CPU cycles. 
 
In the TNC page, APRS+SA stores the last 20,000 bytes received. It 
always saves it. By turning scrolling off, you don't loose the data. 
Turn scrolling back on, and you will see the last 20,000 bytes received. 
If you want to save all the data, save it to disk, file menu, Store TNC 
data to disk. 
 
TNC/GPS and TCP tabs. You can scroll back the list and more easily 
highlight and clipboard copy data. Note - currently, each tab only has 
100 lines of scrollback. If you are fully at the bottom of the list, the 
list will scroll with new data. If you are at the top, and there is 
already 100 lines, you will loose the top most lines that exceed the 100 
lines maximum. The tabs no longer respond to the turning on or off 
scrolling. 
 
 
 
AUTO REPLY 
 
Double clicking on the "Auto Reply" label on the Messages tab will 
open the AutoReply.txt file for editing. AutoReply.txt can be used to 
store frequently used text messages 
 
 
 
INTERNET MESSAGE PORT DESIGNATOR 
 
Unless a message line includes the internet port designator appended to 
the target call in the "Callsign To" dialog box, EG WA4HEI/I, then it 
will be transmitted to rf on the default radio port. 
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MESSAGES, BULLETINS AND EDITING 
 
The maximum length of a message is 65 characters. APRS+SA will split 
a message at a space character, you can just keep typing. The number 
of characters is displayed so that you can keep a message short, if 
your target station can not display the full length message. You may 
choose shorter message lengths to create shorter packet lengths that 
decrease the odds of intermittent noise spike corruption of any 
individual packet, a common lower hf phenomenon due to various forms of 
QRN. 
 
You can enter a message, and choose "Load" instead of "Send". This 
enters the message into the queue in the suspended condition. APRSPLUS 
will start transmitting the message when it hears the target station. 
In this way, you can load a suspended message to a station that is not 
on the air, but who can then receive it the next time that station is 
on the air and is recognized by your APRSPLUS program. 
 
APRS+SA will transmit an outbound message, then 8 seconds later repeat 
it, doubling the interval each time until 20 minutes and it will 
timeout.  It will try again, one time each 20 minutes if it hears the 
target station again. 
 
Note: If a station, for which a suspended message is queued, returns 
to the air with a tnc only, i.e.. a compatible APRS program is not 
operating at the target station when it returns "on the air", then, 
upon hearing the intended recipient station, the senders APRS+ 
software will try to deliver the message to a dumb tnc that will not 
"ack"nowledge reception. The message originating APRS+ program will 
continue the previously described transmit cycle. 
 
Right click to see individual or grouped message line options. 
Control+left click or shift+left click allow user to select various 
combinations of message lines. Editing and manipulation of message and 
bulletin lines is done from the message and bulletin tab pages. 
 
Editing existing message and bulletins may be initiated by double left 
clicking a queued message or bulletin on the message tab page. The 
existing "to call" will be loaded into the message dialog box, 
allowing a total rewrite, if desired of that particular message text. 
 
A single right click on a queued message brings up a message line 
menu, from which Copy Message may be chosen to load both the "to call" 
and the message text, allowing editing of both. 
 
To initiate automatic transmit control of loaded or manually suspended 
bulletin(s), you must right click > Resume Transmission. As these 
generic messages are targeted to a group of stations, they have no 
auto resume transmit option as message lines addressed to specific 
stations. 
 
Right click message line and select Queue Time: Shows time of next 
transmission, in status bar, for the particular line clicked. 
 
 
 
STORED AND DELAYED SEND MESSAGE LINES 
 
APRS+SA has the ability to "Load" messages for delayed sending. The 
message is stored, and when the target station is next heard, the messages 
begin to be transmitted. 
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QUERIED MESSAGE LINES 
 
You can store messages in APRS+SA that can be pulled from the RF list. 
Messages are stored in simple text format, single line, in the APRS+SA 
Data directory with a file name similar to this: NAME.MSG. To query this 
file, send a directed message with ?NAME? as the query text. These files 
can be generated or erased by another program to make the data dynamic. 
 
These message files can also be also be managed by APRS messages, using 3 
commands: 
 
STORE:, RECALL:, and DELETE:. 
 
These commands can be shorted to STO:, RCL:, and DEL:, or even shorter, 
to S:, R:, and D:. 
 
Example: 
STO:name this is the msg text. 
This would create a file, NAME.MSG, that would contain:  "this is the msg 
text.". The stored message can be queried using ?NAME? or RCL:NAME 
 
The message can be deleted using DEL:NAME. 
 
File names using these three commands should not have any spaces. 
 
APRS+SA does not generate messages based on a station's location. That 
would be an interesting project, to have messages for a specific location, 
and when a station entered that location, the message then generated to 
that station. 
 
 
 
MESSAGE LINE "ACK" TIMING 
 
When sending a message, APRS+SA generates one message packet, waits 8 
seconds, if no ACK has been received, it sends it again. Waits 16 
seconds, if no ACK, it sends it again.  When an ACK is received, APRS+SA 
stops sending the message. This is indicated by a "green" message turning 
"black". If your friend returns an ACK, your station will not continue 
transmitting that message. Now you can also see multiple copies of a 
message, depending on what your digipeater path and view of your area 
digipeaters looks like. If ACK are not getting back, APRS+SA does not 
know that a message is received. As for ACKs, APRS+SA will generate an 
ACK for a received message. If APRS+SA see the message again, it will 
again send and ACK, then queue up another ACK that will be sent back 15 or 
20 seconds later. What you need to ask, is why you are not seeing ACKs 
back. APRS+SA will generate 4 packets in the first minute with outgoing 
messages. But then the retries drop off considerably.! 
 
Note, recent versions of APRS+SA support Reply/Acks. If you are in an 
active 2-way messaging conversation, the number of "ACKs" generated in 
significantly increase, but the number of packets is not! This means you 
success in getting message through with ACKs is significantly improved. 
 
 
 
QUERIES 
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Send > Send Message > ?QUERY? > Explain: APRSP & APRSS & APRST 
 
Query a stations Position (?APRSP), Status (?APRSS) or Trace the path via 
which you were heard (?APRST) 
 
 
 
POSITION PAGES 
 
Position tab: A dynamic display (scrolling) list. You can select 
stations on the Position page using Shift-Click, Ctrl- Click, 
dragging, etc. IF you first turn off scrolling, see Commands > 
Scrolling On/Off. 
 
To keep just the most recent position report, right click on your 
station Callsign on the Position tab, and select Keep Most Recent. 
Or, enter a callsign on the History tab, and delete the individual 
position reports. 
 
Position 2 tab: A static display (meaning that the display does not 
scroll) of stations showing callsign with Icon, Lat/Long, Speed, 
Track, Altitude, Time heard, digi path and the data portion of the 
decoded packet. You can sort by any column simply by clicking on the 
column header. Do a reverse sort by holding the Shift key while 
clicking the column header. Data displayed in the Position2 window, is 
determined by a range in miles value. Default is 50 miles. You can set 
it to what ever positive value you want, but note that over all system 
performance may be affected. The window in this experimental version 
is provided with 3 buttons. 
 
1) Map - will generate a map of all highlighted stations in the list. 
2) Update - will recalculate the Range and Bearing based on your 
   current Lat/Long. This is not automatically recalculated in this 
   release. 
3) Clear - clears the entire Position 2 list. You can also generate a 
   map by double clicking on a station or stations. You can use the 
   shift=key or Ctrl-key to highlight multiple stations. 
 
How is ALT set? 
 
If you have a GPS receiver connected, then Altitude is automatically 
entered if altitude is available in the data strings. If you are 
stationary, enter the altitude in your Posit text. Example if you 
altitude is 1234 feet, enter: /A=001235 
 
 
 
TRAFFIC PAGE FILTERS 
 
You can eliminate a lot of this traffic by adding wildcards to the edit 
boxes at the top of the Traffic page. You need to understand what it is 
you want to see and what you don't want to see. The four edit boxes do 
have tooltips to tell you the meaning of each. The first is the "Allowed 
FROM list". Second is the "Prohibited FROM list". Third, "Allowed TO 
list", and finally, "Prohibited TO List". To monitor traffic that is only 
from U.S. stations, enter: A* K* W* N* To eliminate IGate messages, I 
enter  USER* java*  into the Forth list. Using these can make the traffic 
you monitor more meaningful to you rather than seeing every message 
generated. 
 
The traffic page shows ALL messages. Many of which you may have no 
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interest. The options at the top of the page allow you to filter out (on 
in) messages from and to various callsigns. Enter the callsigns you want; 
wildcards are allowed. 
 
More examples: 
 
Prohibited from- 
 
I don't want to see a lot of the traffic directly from the servers, so I 
enter: APRSERVE AHUB* 
 
Allowed to List- 
 
Perhaps, you only want to see messages TO a select list of stations, enter 
that here. I usually leave it blank. 
 
Prohibited to List- 
 
Again, lots of messages I don't want to see. I enter: 
USER*  java* 
 
 
 
REDUCING TCP/IP SERVER TRAFFIC TO APRS+ 
 
There are no settings that will tell the APRS server to not send data 
to the APRS+ client machine. If you connect to port 1314 on an aprsD 
server, you will only receive message packets (and associated position 
packets) from the server. The port still sends anything you send it to 
the other servers, it just cuts down, tremendously, the amount of traffic 
coming to you. This port only passes messages and positions to you, but 
will accept all packets from you. When using a slow computer as an IGate, 
this port works better by reducing the CPU load. It is port 1314. 
 
 
 
RANGE FILTERS 
 
The way I usually set the range filter is from the main  screen of the 
program. I select Commands >Range Filter>640 Miles for example. This way 
of setting the range filter has always worked for me. 
 
However, I have tried setting it the way you do and that works also. 
 
One thing to remember, 640 Miles from where? From your location. You 
must set your location and transmit at least one position report for the 
program to know where you are. 
 
Range Filter only affects map drawing, not the position reports it 
collects and saves. 
 
The Delete Data By Range on the Data Tab of Setup only deletes all types 
of data  periodically when "Enable  Automatic Data Deletion" is checked at 
the top left of the window. 
 
I have observed it deletes the data by range about once a minute, or 
when you click the Do It  button. 
 
The timed data deletion for specific types of data works fine for me 
also. 
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You may need to run the setup.exe file again or re-install the program to 
fix it. 
 
 
 
COMPRESSED POSITION DATA 
 
APRS+SA will not transmit compressed, and the author does not intend to add 
it. The savings are insignificant. You can limit you packet by minimizing 
(read eliminating) the Posit text, and keeping your path to a minimum. 
 
 
 
RADIO DIRECTION FINDING SUPPORT 
 
No, APRS+SA does not support DF via a serial port. Perhaps, if such a 
unit was donated, it could then be added. Otherwise, the demand for this 
feature is very not great. And in my DFing experience, I've beaten the 
Doppler units with my 5 element quad and manual bearings on every 
occasion. Particularly the multi-transmitter hunts. I've been stopped 
by the police more often when using the 5-el quad also!  BH 
 
 
 
POSITION AND STATUS BEACON TRANSMIT TIMING 
 
With change in status text of posit text or lat/long, the new 
information is transmitted on a reset decaying timing algorithm as are 
messages, for fixed stations. 
 
Manually transmitting a position or status beacon resets the timer for 
the next timed report, The same position transmit timer is reset when 
the software responds to received ?APRS? query packets. 
 
 
 
STATUS BEACON SPECIFICATION ANOMOLIES 
 
With the StatusTabOther option set to "0", APRS+SA strongly enforces APRS 
status packet specifications. With it set to "1", it will put any 
non-conforming packet on the status tab IF there is no actual status tab. 
 
 
 
SETUP SETTINGS 
 
There are numerous software features that are only accessible by editing 
the various configuration entries of Settings.ini. They can be made, "on 
the fly", accessed directly by Setup > Settings, left click the + or - 
to open and close a particular part of the configuration tree. Double 
left click on an individual setting to bring up the editor, and edit 
with care. 
 
See the information file Settings.RTF, that should reside in your APRS+ 
directory. The v207 file is duplicated, below, under the SETTINGS.TXT 
topic title. 
 
 
 
SETTINGS.TXT 
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This is the v211 Settings.rtf edited to a simple text format. A text search 
for a particular keyword may very well point you in the right direction, if 
you land within the file's text... 
 
 
Setup Menu Tree: The Setup Menu Tree allows for settings options in the 
Settings.ini file and for items that select different features with in the 
program. The Tree consists of a number of Sections which in turn have a 
number of  Keys. To Edit a Key, double click on the Key, and an Edit 
window will appear with the Key name and current key value.Edit the value, 
and click the OK button to enter the new value. Click the Cancel button to 
abandon the change made. 
 
SECTIONS AND KEYS 
 
CONFIG 
 
UTC,  Display Date/Time Heard in UTC or Local time, 0 or 1 
Ambiguity, The number of position ambiguity digits. 0 to 4. 
OverlayChar, Icon Overlay Character, ASCII character 
RemoteExecute, Allows or prevents remote access to the APRS+SA 
 calculating engine 
IPAddressIndex, Used to determine Internet IP address from 
 computers list of numbers.  Default 1. 
MessageNumber, the current outgoing message number 
MovingThreshold, the number of position reports to determine if a 
 station is moving or not. Default 2 
BulletinStatus, determines whether incoming bulletins are displayed in 
 the Statusbar, 0 or 1. 
Echo, determines if APRS+SA will reply to Message Echo requests. 
Archive, turns on or off Packet Archiving, 0 or 1. 
PositionTabMax - maximum number of stations to display on the Position 
 Tab. Default 100. Use this to decrease CPU utilization on screen 
 repaints 
BitMask, Special feature or diagnostic tool, used as directed by the 
 program Author. 
StatusTabOther, display all non-APRS compliant packets on Status Tab 
 if no Status Packet has been received for that station. 
StatusTabFromCallsigns, only display status packets from given list. 
 It can contain wildcards. Ex: A* K* N* W* 
StatusTabTextSearch, only display status packets with text containing 
 the search string 
StatusbarStationCount - turns on/off display of total number of 
 stations in 4th pane of Statusbar. Default 0. Note, this is set 
 to off to decrease CPU utilization 
CompactionInterval, number of seconds between tactical database 
 compaction.  range 60-300, default 150. 
StatusbarTncInput, show latest TNC packet in the 6th pane of the 
 Statusbar. 
StoreLastPosition, stores last heard position stations, that is 
 preserved as files outside of the tactical database. 
MessageLength, maximum length of a message, value 20 to 110 
 characters.  APRS protocol default is 65. 
EnforceNmeaChecksum, enforces the checksum on NMEA sentences 
 
WX 
 
File, the fully qualified path and name to weather file written by the 
 VWS or WD programs. 
Interval, time in minutes between wx packet transmissions. 
Path, the transmitted path ID as determined in the Unproto Path 
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 window. 
 
DATA 
 
File, the fully qualified path and name to the Data file to be 
 transmitted 
Interval, time in minutes between transmissions. 
Path, the transmitted path ID as determined in the Unproto Path 
 window. 
 
NWS 
 
CodeFile, name of the NWS Shapefile used for Codes 
ZoneFile, name of the NWS Shapefile used for Zones\tab 
MarineFile, name of the NWS Shapefile used for Marine warnings 
Shapefiles, turns on or off the use of Shapefiles 
Boxes, uses shapefiles, but draws boxes around the zone or code 
 instead of outlines 
TTS, use Text-to-Speech to announce incoming warnings 
WaveSound, play wave files with same name as warning type. 
 Example:  FLOOD.WAV for FLOOD warning. 
Morse, use Morse code to announce incoming warnings 
MorseSpeed, sets the speed of the generated morse code, valid values 
 (0.02 -  0.12) 
MorsePitch, sets the pitch in Hz for the generated Morse code 
 (200-1200) 
MorseVolume, sets the volume of the generated Morse code (0-127) 
Enabled, turns on or off the decoding of NWS warnings. 
OverlayAll, turns on or off the decoding of all NWS warnings, not just 
 the currently selected codes and zones 
 
IGATE 
 
MessageCount, the current IGated Message Count 
FillCount, the current IGated Fill packet Count 
AddUniqueID, Adds a unique ID to the path of all gated packets, RF to 
 Internet 
UniqueID, Adds a unique ID to be added to all gated packets, RF to 
 Internet 
 
APRS/IS - Internet 
 
AutoReconnect, turns on or off auto-reconnect to APRS Internet Servers 
InternetPositionCallsigns, Monitor positions only for callsigns in 
  this list. 
InetTimeOut, time after which connection is closed and connection to 
 next Server is initiated 
 
WEB SERVER 
 
PositionTime, Number of hours back to display position data 
TrafficTime, number of hours back to display traffic data 
HistoryTime, number of hours back to display history data 
WeatherTime, number of hours back to display weather data 
WxTrendTime, number of hours back for WX Trend data 
BulletinTime,  number of hours back to display bulletin data 
ObjectTime,  number of hours back to display object data 
StatusTime,  number of hours back to display status data 
RFOnly, display RF data or all data. 
 
KISS - kiss mode settings 
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TxDelay, TX Delay in milliseconds 
Persistence 
SlotTime 
TxTail 
FullDuplex 
RemoveDuplicatePackets, Removed Dupes before going to the Parser. 
 Default =1 
 
SOUNDS 
 
Morse, turn on or off Morse Code in messages 
MorseSpeed, sets the speed of the generated morse code, valid values 
 (0.02 -  0.12) 
MorsePitch, sets the pitch in Hz for the generated Morse code 
 (200-1200) 
MorseVolume, sets the volume of the generated Morse code (0-127) 
DTMF, turn on or off DTMF in messages 
WavOnDigipeat, Name of Wave file to play when one of your packets is 
 digipeated. (File name only; .wav extension is the sole explicit 
 default) 
MorseOnDigipeat, Morse code Text to play when one of your packets is 
 digipeated 
EnableSoundOnNewPosit - Turns On/Off sounds on new position report 
WavOnNewPosit, WAV file to played when a new position report is 
 received 
MorseOnNewPosit, Morse code to be played when a new position report is 
 received 
MorseOnTransmit, Morse code to be played when data is transmitted to 
 RF 
WavOnTransmit, WAV file to be played when data is transmitted to RF 
MorseOnCompaction, Morse code to be played when internal database is 
 compacted 
WavOnCompaction, WAV file to be played when internal database is 
 compacted 
EnableSoundsOnCompaction, disable/enable all sounds on database 
 compaction 
MorsePlaySync, Play Morse Code Synchronously, message plays to 
 completion before next message is played. 
 
EMAIL - settings for use with APRS+SA eXtensions and sending of Email 
 
Host, address of Email host 
Return, return email address 
 
GPS - settings for communicating with GPS receiver, $GPWPL NMEA sentences 
 for the creation of waypoints. 
 
SendWPLForTrackedStations, send $GPWPL sentence for new position 
 reports from tracked stations. 
SendWPLForAllStations, send $GPWPL sentence for new position reports 
 from all stations. 
SendWPLForHistoryStations, send $GPWPL sentence for new position 
 reports from stations displayed on History Tab 
WPLNameLength, the length of the waypoint name to send in the $GPWPL 
 sentence.  Range, 6-10 characters. 
WPLNameFromEnd, select the WPLNameLength of characters from the end of 
 the name or front.  This is used for GPS receivers that only 
 support 6 characters names. 
DeadReckoning - settings for the display of the projected line estimating 
 the location of stations with valid course and speed. 
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 LineColor - Black, Red, Blue, Green, and Yellow (0-4) 
 LineWidth - with of projected line.  (0-4) 
 LineStyle - Solid, Hatched, Highlighted (0-2) 
 TimeLimit - number of hours since last valid position. 
 Stations older then the TimeLimit are not Dead Reckoned. 
 
 
 
UTC OR LOCAL TIME? 
 
Setup > Settings, open CONFIG and double left click UTC to bring up editor. 
 
 
 
MAP CONFIGURATIONS SETTINGS AND INFORMATION 
 
DESCRIPTOR 
 
Includes location data with call, on the SA map. 
 
Maps > Options > APRS; check Include Descriptor. Other options available 
include Altitude Risers, leaders, range circles, new map to front, etc. 
 
CUSTOM MAPS SCRIPTS 
 
These are scripts that can be created to plot data based on the criteria 
you specify. There are a number of functions and criteria you can use 
such as Latitude, Longitude, Range to a specific station or Lat/Long, 
station Icon, posit text search, and others. These can be combined in 
logical expressions, and/or numerical comparisons. 
 
NOTES: Text case is important in function names, and callsign arguments. 
       Map Scripts are evaluated RIGHT to LEFT. 
 
Here is a sample script: Lets say you wanted to show only stations that 
were in Iowa. You can create one that looks only at Lat/Long. Here it 
is: 
 
(Long > -97) And (Long < -90) And (Lat > 40) And (Lat < 43) 
 
Here, there is a numerical comparison to check to see if Longitude is > 
-97,  logically combined with Longitude < -90, then combined with the 
Latitude range. Only stations in this range will be plotted. Others will 
be excluded. Here the "functions", Long and Lat are the numerical values 
of Longitude and Latitude of stations APRS+SA has decoded. The function 
And, performs the logical and function. Note, text case is important in 
function names, and callsign arguments. 
 
Another numerical function is the RangeTo function. RangeTo takes a right 
argument of a station callsign, or a Latitude/Longitude pair.  An And 
example might be as follows: 
 
50 > RangeTo 'KH2Z' 
 
This would plot stations less than 50 miles from KH2Z, provided the 
location of KH2Z is known. The follow script would plot stations less 
than 50 miles from the coordinates of 34,-117. Note the comma, which is 
necessary: 
 
50 > RangeTo 34,-117 
 

Page 27 of 68APRS+SA, APRSPLUS, APRS+ Help File

11/20/02http://www.manistique.org/main/APRS/APRS+SAhelp.html



RangeTo can also have an argument of '' (2 single quotes) which means your 
current location: 
 
50 > RangeTo '' 
 
Summary so far, Logical functions: 
And 
Or 
Not 
Xor 
 
Numerical functions: 
Lat 
Long 
RangeTo 
 
Another function is the From function. This looks at Position data from 
the specified station(s). Several stations can be specified, and 
wildcards can be used. Example, this would include positions "less than 
from KH2Z-9, and all variants of N9XTN": 
 
> From 'KH2Z-9' 'N9XTN*' 
 
The search function, To, will search the Unproto To for a string match. 
The following will search for the unproto To of APS211: 
 
To 'APS211' 
 
Searching for a portion would also work: 
 
To '211' 
 
Or, the following will pick out most APRS+SA stations: 
 
To 'APS' 
 
The Text function will search for text strings in the Posit text of 
stations: 
 
Text 'APRS+SA' 
 
Text 'PHG' 
 
The last function I will discuss is the Type function. This one can be 
used for a number several types of searches. 
 
The following searches for the digipeaters GATE and ECHO in the path: 
 
Type 'HF' 
 
This one searches for stations that are listed in the IGate tab of 
APRS+SA, meaning that they have transmitted an IGate packet and has been 
decoded by APRS+SA: 
 
Type 'IGATE' 
 
The TRACKER argument looks for all NMEA string position reports: 
 
Type 'TRACKER' 
 
The IGATED argument looks for the last position as having been transmitted 
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via an IGate: 
 
Type 'IGATED' 
 
TRACKED will show stations in your tracking list. 
 
A little trickier is the ICON Type argument, It requires a second, left 
argument: 
 
'*&%'  Type 'ICON' 
 
Note, if you want to use the digipeater symbol, you need to enter it 
twice.  Why?  Because that is the way I programmed it! 
 
'##*&%'  Type 'ICON' 
 
Or for those stations, only, claiming to be digipeaters, enter: 
 
'##'  Type 'Icon' 
 
Or, just: 
 
Type 'DIGI' 
 
So the right arguments to Type are: 
'IGATE' 
'TRACKER' 
'TRACKED' 
'IGATED' 
'HF' 
'ICON' 
'DIGI' 
'OBJECT' 
'Mic-E' 
'D7' 
'WX' 
 
The only left arguments to Type, exist for the right argument Icon. They 
are detailed, above. 
 
In the Custom Map Editor, there are several options. A time filter which 
will only look back the number of hours specified. Also, the History 
check box will enter the callsigns of stations found into the History tab 
of APRS+SA. The Delete Posits button will delete stations that match the 
criteria of the script. The Keep Posits that Match does the same thing 
when the map is drawn automatically, providing another way to trim the 
data you keep stored in the active internal Tactical Database. 
 
To find IGates with in 100 miles of N9XTN, you might use the following Map 
Script. 
 
((Type 'IGATE') And 100 > RangeTo 'N9XTN') Or From 'N9XTN' 
 
To find the digipeaters with in 100 miles of N9XTN, try: 
(('##' Type 'ICON') And 100 > RangeTo 'N9XTN') Or From 'N9XTN' 
 
Show Quake objects: 
('Q' Type 'Icon') And Type 'Object' 
 
Once you have created your script, you can save it to a name you specify. 
The new name can have its own MOP file (Map Options). The new map can 
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have its own overlay file to add drawing objects to the final map. 
 
There are a number of possibilities. If you create a favorite, let us 
know. 
 
Here is a custom map script example to show only stations in Iowa (as can 
best be defined by simple longituude and latitude boundaries), and 
excludes stations that use the Satellite Icon, and ARISS. 
 
NOTES: Text case is important in function names, and callsign arguments. 
       Map Scripts are evaluated RIGHT to LEFT. 
 
So the From 'ARI*" is calculated first, then Or'd with ('S' Type 'Icon'), 
not-ed, and then added with the rest of the criteria.  All my code reads 
right to left!! 
 
(Long > -97) And (Long < -90) And (Lat > 40) And (Lat < 43) And Not ('S' 
Type 'Icon') Or From 'ARI*' 
 
Put this file into your Map subdirectory of APRS+SA. It will now appear 
in the Custom map dropdown on the Maps toolbar. No more satellites. Just 
Iowa stations. 
 
Brent Hildebrand, KH2Z 
 
 
 
STREET ATLAS MAP CAPTURE TO APRS+SA BITMAP WINDOW. 
 
1) Open the APRS+SA Bitmap window 
2) Draw a map in SA, do not zoom or pan the map. You can remove the SA 
   draw objects if you wish 
3) In the APRS+SA bitmap window, right click on the map, and choose 
   Paste SA.You will now have a screen capture of SA,that is 
   calibrated and on which Icons can be drawn, and objects created. 
   NB! You can not resize the bitmap window, or zoom it or out. 
 
 
 
VIEW.TXT APPLICATION FOR CUSTOM BIT MAPS 
 
The View.txt data, is used when you do not use map drawing from other 
sources. If you have the map being updated by other means, this can 
change the magnitude. Icons will be drawn correctly, because the screen 
gets calibrated. But if you want to have a static map display, turn off 
all other map drawing functions, then use the Views menu to set the SA 
screen. Am I making any sense? If you are repainting the screen from 
methods other then Views, then you need to adjust your MOP file for 
that map. You can often do this easily by redrawing the map, then click 
on the Maps button on the Map toolbar. The MapOptions window will open, 
set your magnitude on the "Center & Mag" tab, then save the file. 
 
To create a map view that I want to use for a specific map I do the 
following: 
 
1. Turn floating toolbar on in APRS+ 
 
Not required but makes things a bit easier. 
 
2. Switch to SA8 
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3. Create a map view that I like. Let's say the western 80% of Iowa. 
 
4. Save the map to a unique file name.. DO NOT! save as any of the 
Map7 or Map#...give it a unique name like Iowa.sa8, so you will 
recognize a non ambiguous name, easily. 
 
5. Click on Map in the Floating Tool Bar (brings up the mop window) 
 
6. File - Read Map Configuration 
 
7. Select the previously saved UNIQUE! Mapname.SA8, eg. above:Iowa.sa8, 
to read configuration from. 
 
8. Make appropriate selections in each of the tabs of the .mop box. 
 
9. File - Save As UNIQUE! Mapname.mop, eg. above: Iowa.mop 
 
10. Switch back to APRS+SA 
 
11. Go to the Maps Tab of the main program. Go to white box with "7 All 
Stations" on its left. 
 
12. Type in "Iowa" , no quotes. 
 
13. Now, go to Select maps button and Iowa will MAGICALLY appear in the 
map list under Maps!!! 
 
14. Select maps as you will for the big white box to be redrawn at the 
specified interval (already knew about that part). The trick is, the newly 
NAMED maps won't appear in the Select Map List, UNTIL and UNLESS you have 
put their name in one of the 9 white boxes adjacent to the buttons for "1 
All Reports" through "9 All Stations" 
 
You can follow the steps listed above and put your NAMED maps in slots 
6,7,8 and it works fine. I'm betting it will work anywhere, but with as 
much trouble as I've had to this point, I'm not vouching for anything that 
I haven't actually done with my own fingers. 
 
Once I am sure that I have explained this properly, I will rewrite this 
without all the comments, just a "by the numbers" description so others 
can make use of it. I can tell from the responses that I have gotten that 
this has been a big problem for a lot of people. 
 
Now I have four maps in my "redraw list" (the big white square under the 
Maps Tab of the main program). NWS, IAcent, CentPlains, Iowa. Each has its 
own distinctive magnitude and center, as well as Map Features (cities, 
rivers, track lines, circles etc) 
 
NWS shows the entire country. 
IAcent shows the contiguous counties to my own county. 
CentPlains shows about a 7 state area from Iowa to the West and South 
(Primary Bad weather track) Iowa shows the western 80% of the state with 
county lines and county names. 
 
At last....peace of mind....for a little while. 
 
Thanks for all the help, and any additional feedback you want to provide. 
I'll then clean this up and post it so others will not have to go through 
what I have. It is a simple process, IF IT IS CLEARLY outlined. Otherwise, 
for me, it was like not knowing the secret handshake AND a password. 
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MAP MAGNIFICATION - .MOP FILES 
 
What ever happens in Street Atlas is not reflected back to APRS+SA. 
 
To change the way maps are displayed, you need to edit the Map Options 
(MOP) file.  In v1.99 you can click the Maps button the Map Toolbar. 
In all versions, you can use the Commands menu, and select the Map 
Features option which has a speed key of Ctrl-Shift-M.  From the Map 
Options window, go to the Center & Mag tab, and you can adjust the 
Minimum and Maximum Magnitude to desired levels. The default name for 
the MOP file is MapOptions.MOP.  Every map can have their own MOP file 
where the MOP file is named after the map.  NAME.MOP. Thus, different 
maps can have different views if desired. 
 
MAPS, MOPS and other things. 
 
APRS+SA Maps 
 
1) Map Names: All APRS+SA maps have names. They are followed by either a 
+A.SAx or +B.SAx where the x in SAx is the version of SA you are using. 
Example, Map2+A.SA8. 
 
2) MOP files: This are Map Options files. All maps use a MOP file. The 
MOP file has the same name as the Map you are drawing.  Map2+A.SA8 would 
use the MOP file Map2.MOP. If there is no defined MOP file, then the 
MapOptions.MOP file is used. MapOptions is the default MOP file for all 
maps that do not have a MOP file.  When you first install APRS+SA, there 
are no defined MOP files, and MapOptions.MOP is used. If you edit 
MapOptions.MOP, then these changes apply to all maps. 
 
3) Defining MOP files. Click the Maps button on the Maps toolbar, or use 
the Commands menu, or use the keyboard shortcut of Ctrl+Shift+M to open 
the Map Options window. Map all the changes you desire on the various 
tabs, and save the file. If you want to make a specific view for Map2, 
do File+Save As, and give it the name Map2. Now, when ever Map2 is drawn, 
it will use the options contained in Map2.MOP. 
 
4) A MOP Shortcut: Lets say you want to have a specific view, that has a 
fixed center and magnitude. Setup SA (not APRS+SA) to show the view you 
want. Save the map from SA and give it a name you will remember. 
Example, a view showing the lower 48 states, I might name US48.  Open the 
Map Options window, go to the Center & Mag tab.  The from the MOP windows 
File menu, select the Read Map Configuration, and select then the US48 
file you have saved previously. That maps Center Lat/Long and Magnitude 
will be read and entered into appropriate slots. Check the Fixed Center 
and Fixed Magnitude, and save the MOP file - give it the name you desire 
for the map you desire. Remember the naming convention above. 
 
5) Map Overlays:  You can include map drawing objects with your maps. 
These can be of any type of drawing object that SA supports. 
A) Global - drawn with most maps. The Global overlay is an SA map 
   with the name GLOBAL.SAx. All drawing objects in GLOBAL.SAx will be 
   drawn with all maps. B) Specific map overlays: This is a file with 
   the same name as the map being drawn.  Example. Map2 will use the 
   file Map2.SAx as an overlay C) Dynamically loaded map overlays.  This 
   are drawing objects you load from the Main program window's File menu. 
    Select File+Open Map Overlay File. The file you select will be read, 
   and its objects included with each new map draw. You can clear these 
   objects by selecting File+Clear Overlay File. D) DF Objects. You can 
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   generate DF bearing lines (Ctrl-D to activate the DF window). Enter 
   the DF Fix parameters, and click Map. Click Clear to delete these 
   objects. 
 
MOP file accepts all combinations and permutations of Lat/Long that 
other locations in APRS+SA with Lat/Long accept. 
 
 
 
MORE .MOP FILE CONFIGURATION INFORMATION 
 
There is a way to display Power-Height-Gain circles, but this 
is not the same as the weather circles. They are completely 
different animals. Many parameters can be changed to show 
how the map is displayed including the zoom level, track lines 
for a moving station, and the detail level of the map.  Many of 
the MAP settings that you would select in SA can be controlled 
from the MOP files. 
 
What are MOP files and why did I mention it. There were several 
other posts that contained questions about how the SA settings 
got changed or why my map looks different. So I will try to 
briefly explain this very nice feature quickly. I learned all about the 
MOP files when setting up APRS+SA for the Rocket City Marathon in 
Huntsville and we have several maps and zoom levels configured so that we 
would get a birds eye view of the whole track, portions of the track, and 
zoom to appropriate levels automatically. All we had to do is sit back 
and watch the show. 
 
I am not going to go into full detail, but you can play with it yourself. 
 
Click on Commands -> Map Options 
 
This will give you a window with four tabs: 
 
1. Symbols & Text 
    Allows you to control Symbol, Text, and Track Lines size and color 
 
2. Center & Mag 
    Allows you to control the ZOOM level control of the map 
 
3. Map Features 
    Allows you to control map features displayed on SA 
 
4. Circles 
    Allows you to control the thickness of the line on a circle. 
    You can also specify a fill color if desired. 
    This has nothing to do with NWS circles (red or yellow) 
 
5. APRS 
    Allows you to control APRS functions on how some things are 
    displayed. You can select including range circles, track lines, track 
    lines included in the zoom display, and a few others here. 
 
These settings determine what options are used for specific maps.  I 
believe the default file will be MapOptions.mop so be careful how and what 
you save. 
 
What do I mean by specific maps.  If you display your SA map on the screen 
and look in the top left corner of the window on the title bar, you will 
see something like MapOption, Map9, Map5, etc followed by some other text 
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and the SA file extension like .sa8  Mine shows .sa8 because I am using 
Street Atlas version 8 and I have APRS+ writing SA8 files on the updates. 
The MOP files are located in the DATA directory under the APRS+ main 
software directory on your hard drive. 
 
When I look for MOP files in this directory I see the following: 
 
Map5.mop 
Map6.mop 
Map7.mop 
Map8.mop 
Map9.mop 
Digipeaters.mop 
TrackMap.mop 
MapOptions.mop 
 
You will not have all these files. Do not worry, because you are going to 
create them if you want. 
 
If you go to the "Maps" tab in APRS+ and look at all the maps you can 
display, then you can realize how many MOP files you could have to control 
how each of these maps will look to suit your own desires. Try clicking 
on All Stations which uses Map9 as a default. Now look at the top left 
corner of the SA window and see what the title bar shows before the "+" 
sign in the text. Mine shows Map9+B.sa8. Do not worry about all of this 
except the Map9 at this point. If you create a Map9.mop file, you will 
find that you can control how it is displayed. The same is true for the 
Digipeaters button on that screen. Yes, if you have a Digipeaters.mop 
file you can control how it looks. In mine I have the range circles 
activated so I can see where all the digipeaters are located and also see 
there range circles to see where we need new digipeaters or where a 
digipeater may be off the air. 
 
Does all of this sound good. I hope I can explain it so you can get to 
the meaning of it. 
 
How do I create a MOP file? 
 
Click on Commands -> Map Options 
 
Change all the settings you would like to have and then save the file as 
the proper mop name. For instance, if I want to create a Map9.mop, I will 
click on Commands -> Map Options. Then, I will make my changes and click 
on File -> Save As, and then the name of the map I want to affect.  It is 
that simple.  A word of caution.  You should turn off all automatic map 
updating functions when doing this. If a map gets updated in the process 
of you making changed, you will quickly find that your settings are most 
likely being changed by some unknown force. This includes turning off 
auto map update under the Track tab in APRS+. Also make sure the enable 
box is not checked under the Maps tab. This will help make things go 
smoother in making a MOP file and saving it before the auto functions in 
the software does its thing before you do. 
 
If you do not know what map is created on the Map tab for each button, 
then click on the button and look at the title of the SA window. You will 
find the name of the map preceding the "+" symbol in that text. All you 
need to do is create a MOP file with that name, save it, and the next time 
you click on that button the screen will look just like you set it. 
 
It takes a little while to get use to what all those MOP settings can do 
for you so you will need to do a little experimenting. 
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BITMAPS - CUT AND PASTE 
 
I am a very happy APRS+SA user in Canada but I am an unhappy APRS user 
in Canada because of the serious lack of maps for Canada. 
 
The only solution for us is this: 
 
www.mapblast.com or www.mapquest.com 
 
Make the bitmap and load them into APRS+SA. I have done maps for our 
use here and they work well enough. I cut and paste using Paint Shop 
Pro. 
 
 
 
TRACKING MAPS 
 
The selective tracking controls ONLY work with Street Atlas. If you are 
trying to use the bit map mode activated with the "Bitmap" command on the 
top menu bar that uses simple scanned BMP images of maps, it won't work. 
 
Assuming you are using Street Atlas (the ONLY way to really use this 
program!): 
 
Do you have the "Track Any Moving Station" check box on the Track panel 
checked??  This will cause all mobiles that fall through your mileage range 
filter to be tracked. Clear this box to track only the ones listed in the 
third ("Tracking List") column. DO check the first three boxes ("Enable 
Tracking", "Auto Map Update" , and "Zoom to Most Recent". 
 
Basically the Maps tab allows you to call up several different pre-defined 
sets of plotted presentations on top of the Street Atlas background such as 
weather only, digipeaters only, etc. You can also have the program present 
several different map views automatically in rotation every few seconds. 
 
The Range Filter is a display filter and selects stations that are with in 
the set Range. If you map is displaying data outside this range, it 
probably has to do with the Track lines; satellites have long track lines. 
To not include the track in the map zoom, uncheck the "Zoom Includes 
Tracks" on the APRS tab of the Map Options window. 
 
Maps by Icon are just that - maps of stations with the specified Icon. 
They do not affect any other maps. 
 
As for the numbered maps, 1-9, these relate to the stations listed: 
1) All Reports, means every position report currently loaded, current and 
   old positions. 
2) Latest Reports, displays only the most recent position. 
3) All Tracked - all position reports for stations in the Tracking list. 
4) Latest Tracked - Most recent position report for stations in the 
   Tracking list. 
5 and 6) Station List - Most recent position report for stations specified 
   in the Custom Map List on the Lists tab of Setup. 
7,8,and 9) Most recent position report for all stations, same as Map2, 
   with a different name. 
 
Why have maps which have the same station list, but different names? 
Each map can have its own Map Options file, (MOP File) and each MOP file 
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can have a different definition for how the map is to appear. Different 
map centers for example, of different level of detail. Track lines on or 
off, different map instance, etc... 
 
You can put the map name into the Map drawing list, the center list on the 
Maps page, and have those maps be redrawn at a given interval.  You can 
manually redraw the maps by pressing Ctrl+0 to draw the next map in the 
list. Map1-9 can be manually triggered using the key combination, Ctrl+9 
-> Ctrl+9 
 
It is important to understand that every map generated can have an 
associated Map Options file (MOP) and overlays.  MOP files control map 
appearance, such as map center, fixed or variable centers, map magnitudes, 
display of various features such as inclusion of minor or major roads, 
place names, railroads, text size and color, and whether track lines are 
on or off. If a map has a MOP file defined it is used, if not, then the 
default file MapOptions.MOP is used. Using the numbered maps, 7,8, and 9 
for example, the only difference between these would be the MOP file. If 
no MOP file is defined, then the default MapOptions.MOP is used, and they 
all look the same. 
 
What is the name of the MOP file?  Every map generated by APRS+SA named as 
follows:  MAPNAME+A.SAx or MAPNAME+B.SAx. The associated MOP file will be 
MAPNAME.MOP. You create MOP files from the Map Options window opened from 
the Menu Command+Map Features or by clicking the Maps button on the Maps 
toolbar in v1.99. Set your desired parameters, and execute File+Save and 
give the file the name MAPNAME. 
 
Overlays - there are several layers of overlays. 
Global - If the file Global.SAx is defined, it is loaded and included with 
every map generated Run time globals, and loaded from the File+Open ... 
Overlay File.  You can open any number of files to be used as a runtime 
global. These overlay objects are deleted from the File+Clear Overlay 
file. Additionally, just like each map can have a MOP file, each map can 
have an associated Overlay file named MAPNAME.SAx. Also if any DF lines 
have been plotted, they are included as an overlay and these are 
controlled from the DF window (Ctrl-D) 
 
Note - SAx  applies to the version of Street Atlas you are using. If you 
specify SA7, then the file GLOBAL.SA7 is used for the overlay, not 
GLOBAL.SA6. 
 
 
 
MAINTAINING MAP CONFIGURATIONS, S'MORE 
 
When APRS+ switches from the A map to the B map and back again all 
map features settings are lost and a world view is thrown up on the 
display. To keep map settings, You will want to setup MapOptions (MOP) 
files for each map you want to draw. Click the Maps button on the Map 
toolbar to open the MOP window. If no MOP is defined for a specific map, 
then the default MOP file, MapOptions.MOP is used.  To make a MOP file that 
is specific for the map you want, use the name of the Map without the 
+A or +B. The MOP file for NAME+A.SAx would be NAME.MOP. You can set map 
centers, zoom, features, etc. via the MOP files. 
 
 
 
MAP ICONS 
 
1) Click on the Maps drop down on the Maps button on the Maps toolbar. 

Page 36 of 68APRS+SA, APRSPLUS, APRS+ Help File

11/20/02http://www.manistique.org/main/APRS/APRS+SAhelp.html



2) Select Views+Enabled Icons 
3) Enable live update if you wish. 
 
Now, Icons will only be in the correct location if APRS+SA has drawn the 
map. You can not pan or zoom and expect to have the icons in the correct 
place. 
 
You must have a printer installed in Win9x in order for icons to appear on 
maps. This is a relatively "obscure" requirement that is easy to miss. 
So...even if you don't have a printer attached to your machine and never 
will, you must install a printer in Win9x if you want icons to work with 
APRS+SA 
 
Then, click on the Maps dropdown, on the Maps toolbar, select view, and 
Enable Icons. Note, Icons will only be in the correct location if you do 
not zoom or pan the map manually. The map must be drawn by APRS+SA. You 
can setup Views, defined in the views.txt file, and editable on the Views 
menu under the Maps dropdown. Views entries are in the form of: NAME, 
LAT, LONG, MAGNITUDE Examples: Seattle,47.6,-122.3,10 Washington,48,W120,7 
 
This way, you can zoom to a specific view, and have Live Update of Icons 
and callsigns. 
 
You must have a LOCAL printer installed for map icons to work in the 
manner described. Having only a NETWORK printer driver installed means 
that the icons won't be drawn unless you have the network connected and the 
printer is online. 
 
 
 
MAP ICON OVERLAYS 
 
APRS+SA can transmit an Overlay character. Enter that character in the 
Settings section under setup (v2.01). See the Config section, 
OverlayChar key. Default is empty. eg. The recommended icon for I-gates 
is the alternate gate icon with an I overlay. 
 
 
 
MAP OBJECTS 
 
1) With SA showing, select Object+Create Object from the Map. 
2) Keep the focus on the Objects Editor, but move the cursor over the map 
   so that the Lat/Long changes 
3) From the Object Editor, click Ctrl-M to capture the cursor coordinates. 
 
Objects can have an expiration time. This can be entered in the 
Object editor by two methods. The upper Date/Time entry allows for 
specifying the year, month, day, hour, and minute of expiration. The 
lower Date/Time entry allows for an offset of time in Hours and 
Minutes up to 24 hours. Unchecking the upper Date/Time box, means the 
object does not expire. Objects are transmitted in an initial decaying 
interval to the final transmit interval. Setting the state of an 
Object to "Killed", Sets the object expiration time to .15 hours. 
With the decaying transmission times, this means the killed packet 
would be send 6 times and quit. 
 
Object names are now included in the Ignore List, with wildcards. 
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WEATHER 
 
CORRECT WEATHER ICON = CORRECT DATA DECODING 
 
Make sure your icon is an underscore. APRS+SA only sends weather as a 
full weather packet (including position). This requires that you use the 
standard weather icon (blue WX) or the alternate weather icon (green WX). 
The blue or green WX icons with a black circle around them is a W and is 
not valid for a full weather packet (this symbol should only be used for 
NWS locations). Using the incorrect icon is likely to cause decoding 
problems in other software. 
 
 
 
WEATHER INSTRUMENTS DISPLAY FILE 
 
How does aprsplus locate the file that is need from Virtual weather or 
weather display? 
 
In the settings.ini file there is a section for WX. For example: 
 
[WX] 
File=C:\WDisplay\WXnow.txt 
REM File=C:\vws\data\wxreport.txt 
Interval=10 
Path= 
 
To use both VWS and WD alternate between the two by moving the REM to 
whichever one you don't want to be using at the time. 
 
You can also find this in APRS+ at (Setup-Settings-WX) you then double 
click on the line you want to change and take it from there. 
 
 
THIRD PARTY WEATHER SOFTWARE 
 
Weather transmit using data files written by 3rd party programs 
such as: 
 
Weather Display, http://www.weatherdisplay.de/english/ 
Virtual Weather Station, http://www.weatherconnect.com/Products/Descriptions/vws.asp.
 
To enable WX transmit, edit or create a file named SETTINGS.INI 
Add the following Keys: 
 
[WX] 
File=path\name (eg. FILE=drive:\path\wxnow.txt) 
Interval=10 
 
Where path\name is a fully qualified path and name to the file written by 
the 3rd party programs, and Interval is the time in minutes.  When APRS+SA 
transmits the Weather data, it deletes the file, so that no duplicate 
transmissions occur.  APRS+SA can be forced to transmit WX from the Send 
menu,  select "Send Weather File". 
 
1) New - Weather graphic trending for the 8 displayed parameters. 
 a) Stations to trend are selected by checking the call sign on the Weather 
    tab 
 b) Select the trend to plot using the "Checked" button on the Weather tab 
 c) Select stations manually or using the "Select" button.  WXTREND*.TXT 
    files can be used to store call sign lists and then quickly recalled 
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    later. The WXTREND*.TXT files can be created, edited and deleted from 
    the "Select" button. 
 d) Trend plots can be zoomed using the mouse via click and drag 
 e) Trend data requires more RAM for storage. The Data page of Setup has 
    new choices to support weather trending.  You may consider increasing 
    the WorkSpace size on the Program tab of Setup if you plan to do any 
    long term trending, or to collect trend data from APRServe.  Default 
    is to trend RF data only. 
 f) Trend plots for individual stations can be drawn by highlighting the 
    station(s) and using the "Highlighted" button on the Weather tab. 
    "Highlighted" and "Checked" buttons work the same except for which 
    stations are selected 
 
APRS+SA will work cooperatively with other weather program to provide 
transmission of weather data. These programs will write a file which 
APRS+SA will read and transmit. Many different weather stations are 
supported by these programs. 
 
Weather Display, $49.00 for life time registration. 
http://www.weatherdisplay.de/english/ 
 
Virtual Weather Station 
http://www.weatherconnect.com/Products/Descriptions/vws.asp 
 
You should evaluate any program for suitability in your application. 
 
 
 
WEATHER TREND DATA 
 
Weather trend data - You can now easily identify which station 
generated a trend line on a multi-station trend plot by moving the 
mouse over a line and letting if "hover" on the line. The Callsign 
will be identified in the trend plot window's status bar. This makes 
it convenient when you plot multiple stations in separating out which 
line belongs to what station 
 
WX trend data is now stored externally in data files in the 
new WXData subdirectory. These files are named as follows: CALLSIGN.wx 
where CALLSIGN is the call of the transmitting station. The data within 
each file is 9 8-byte floating point numbers per record. The first number 
is a date/time stamp, the remaining 8 are the decoded weather parameters. 
All other aspects of displaying trends remain the same. The Data page now 
has 2 options to enable saving of trend data and to limit it to just RF 
stations. NOTE - trend data is no longer purged as was the case 
previously with the Data page. You can now have extended periods of trend 
data. Additional work will be required to be able to trim these files. 
 
 
WX Alarms 
 
Individual stations can now have alarms set for the various parameters, 
such as a low temperature, high temperature, high wind speed, etc. To set 
an alarm right click on a station on the Weather page to bring up the WX 
Alarm window. Enter the parameters desired. The program tests for either 
Greater Than or Less Than. So entering a low temperature of 32 for an alarm 
value, would cause an alarm when the temperature was below 32. You can 
enter alarms for any station from the Alarm window by entering the call 
sign of the station desired, entering the parameters, and clicking OK. 
To delete a station from the alarm list, enter their call sign, and click 
the Delete menu. The call sign drop down list on the WX Alarms window, 
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shows a list of all stations for which alarms are currently set. Or from 
the APRS+SA calculator, enter: #disclose WX_ALARMS 
 
When an alarm is triggered, several things happen: 
1) The ALARM.WAV file is played. 
2) A message is placed into your message Inbox with the call sign of 
   the station causing the alarm, and what event triggered it. 
3) if you have Port 2 open, the RTS line is Set so an external event can 
   be triggered.  External alarms are cleared via the menus: 
   Commands+Clear+Clear Alarms. 
 
Alarm data is stored in the DATA\WXALARMS.DAT file. 
 
The WX Alarms window can also be activated from the Commands menu with 
shortcut keys of Ctrl+Shift+W. 
 
Note: You can enter 32 for a low temperature alarm, and 9999 for a high 
alarm.  This will effectively prevent a high alarm while having a low 
alarm set. 
 
When you want to send the wx file manually, look at the bottom of the 
Send menu. 2nd from bottom, above Send Tactical is "Send WXNOW.TXT", 
if your version of APRS+SA supports the feature I'm talking about. 
 
It really isn't going to send that file...it is going to send whatever 
file you defined in settings.ini 
 
This will immediately send the wx string out, as opposed to waiting for 
Interval=10 or whatever you have it set to. 
 
 
To shut off wx alarm or change settings: 
 
Open the WX Alarm window: Commands>Set Weather Alarms>Callsign 
 
Select callsign, and delete or modify the menu. 
Click OK to close the window. 
 
 
Clearing NWS page 
 
Shift-Click and Ctrl-Click, standard windows keyboard functions, works for 
doing multiple select. Ctrl-X will delete them.  Or you can click the 
Menu button, and clear them all. 
 
Click the Menu button, Clear Page. Then select the Clear Overlay if you 
wish. 
 
Packets that do not self purge do not have an explicit expiration-  but 
some do have an implicit expiration. All packets coming out of my server 
have a sequence tag. This along with the "from" call makes all packets from 
the same NWS bulletin (or part of bulletin that have the same geographical 
scope) "associated". Any packets matching the "From" call and the first 4 
characters of the sequence tag the same should be eliminated at the same 
time. This means the only problem then would be the stray packet with no 
expiration time and no associated packet with one, such as solar weather, 
and tsunamis; or for various other reasons outside of the Wx data server. 
73 de kg5qd, Dale. (the person that fills up your NWS tab with 
data from his NWS wx data server.) 
 
The 24 hour limit will be reinstated on the next revision of APRS+. 

Page 40 of 68APRS+SA, APRSPLUS, APRS+ Help File

11/20/02http://www.manistique.org/main/APRS/APRS+SAhelp.html



 
 
 
NWS SHAPEFILES DIRECTORIES 
 
Where to put the NWS shapefiles so that APRS+SA will use them? 
 
The z_* and c_* files need to be put right in the NWS directory under your 
APRS+SA main directory. However, that alone isn't enough. You also need to 
select Setup-Settings, click on the plus sign by NWS and you will see two 
file identifiers, one for the c_* and one for the z_*. If you don't change 
the text of the parameters to match the spelling of the actual NWS shapefiles, 
it still won't work. 
 
NB! to emphasize...There are entries in your settings.ini file that tell 
APRS+SA what the names of the NWS files are. As the names of the files are 
liable to change be aware that APRS+ must be told what the new file names 
are, or the files are useless. 
 
A good description for setting up NWS mapping is at: 
 
http://www.nwaprs.org/nws.htm 
 
 
 
NWS TAB 
 
PERUSE NWSTAB.TXT, POSITION2TAB.RTF, SETTINGS.RTF ,,, 
 
This tab decodes NWS warning messages as generated by Dale Huguley's, 
KG5QD, server application which translates the NWS messages into APRS 
type messages. The NWS tab can automatically map WX warnings using Street 
Atlas. The "From" column shows the weather service station issuing the 
message, the "To" column shows the type of message, such as WARN for 
Warnings, ADVIS for Advisories, WATCH for Watches, etc. The "Expires" 
column is the date and time the message is do to expire. The "Type" 
column shows the type of message, such as FLOOD for possible Flooding, 
SVRTSM for Severe Thunderstorm, TORNDO for Tornado, etc. The Zones/Codes 
column is the NWS designation for the location that applies to the message. 
The "Posted" column is the date/time that the message was generated.  The 
"Sequence" column is equivalent to the message number of regular APRS 
messages. The Sequence number contains thePosted date/time information, 
and the line number of multi-line ! weather message. Click on the 
Sequence column will sort the list by time of origin, and order the 
message in sequence with in multi-line messages. You can sort the list 
by clicking any column. See theNWSTAB.TXT file in the program distribution 
for more information. 
 
 
NWS Tab Notes 
 
Subject:         [aprsplus] APRS+SA v1.99YQ - NWS Tab Notes 
Date sent:       Wed, 4 Apr 2001 20:26:25 -0700 
 
APRS+SA NWS Tab 
Purpose - decoding, displaying, and mapping of NWS Weather related 
messages. 
 
The NWS messages that APRS+SA decodes are generated by a server written by 
Dale Huguley, KG5QD.  These messages are in the following format. This 
information is from the following URL: 
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www.ae5pl.net/html/nws_databases.htm 
 
CWAPID>NWS-TTTTT:DDHHMMz,ADVISETYPE,zcs{seq# 
 
CWA is the NWS office (See databases to the left). 
PID is the product Code (See database to the left). 
TTTTT is ADVISE, WARN, WATCH, etc. 
DDHHMMz is the expiration time. 
ADVISETYPE is things like FLOOD, FLASHFLOOD, SVRTSM, SEVERE_WEATHER, etc. 
zcs are the zone codes, county codes (See databases to the left), or 
statement text. {seq# is decoded as: 
 
The first three characters are the "issue time" compressed by assigning 
0-9 as themselves A-Z as 10 thru 36 a-z as 37 - 62 --where it is DHM (Day 
of the Month-Hour in 24 hour format and Minute). Up to 16 this reads as 
hexadecimal so {A8B** was issued on the 10th at 08:11 Z. 
 
The next two characters are line numbers which (along with the "From Call" 
) make the packet unique. Any packet with the "from Call" and the first 4 
digits of the sequence matching are "associated" packets- in other worlds 
they are from the same product or portion of product that is defined by 
UGC codes. 
 
The final character is for sorting and for assigning some priority to the 
various outputs (objects, headlines, packets that highlight counties, 
background info). 
 
 
The APRS+SA NWS tab shows the following columns: 
 
From, To, Expires, Type, Zones/Codes, Posted, Sequence, and Path. 
 
From:  This is the CWA of the NWS office, and PID 
To: is the TTTTT, or level of warning 
Expires: is the Expiration time of the message 
Type: is the ADVISETYPE 
Zones/Codes: are the zone and county codes. There can be multiple zones 
or counties in one message. Posted: This is the date/time the message was 
posted. This is taken from the Sequence number Sequence: is the sequence 
number of the message. Path: is the APRS path by which the packet was 
received. 
 
 
NWS TOOLBAR 
 
Map Button: This button calculates a map Overlay from the Zones and Codes 
of decoded messages, and them generates a map from this overlay. 
 
Menu Button: Use Shapefiles - This option tells APRS+SA to look for and 
use the "Shapefiles" for drawing either a rectangle or an outline border 
around the warning area. These "Shapefiles" are available online from the 
NWS. A Shapefile is a standard of ESRI, which produces GIS products such 
as ArcView. A Shapefile is actually 3 files, a DBF database file, a SHP 
file which contains the various "shapes", and a SHX file which is an index 
into the SHP file. These files are quite large, but contain all the 
information for CONUS and non-CONUS areas covered by the NWS. They can be 
downloaded from the locations below. Note, the NWS does update these 
files periodically, and the actual file name can change. The main NWS Map 
catalog is located at: 
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http://isl715.nws.noaa.gov/mapdata/newcat 
 
(download the zips from "Zone Forecast Areas" and "AWIPS Counties"). 
 
Shapefiles for the coastal zones ("Coastal and Offshore Marine Zones") may be 
found at Pete Loveall's AE5PL web site as a database lookup. You can access 
all three of the databases for review at 
 
http://www.ae5pl.net/html/aprs.htm 
 
for the current coastal and offshore shape files. 
 
APRS+SA users that prefer circles can download updated zones.txt and 
codes.txt files from (http://aprs.ae5pl.net). These APRS+SA users need to 
stop and start APRS+SA after installing the zones.txt and codes.txt files so 
APRS+SA rebuilds the indexes. 
 
The same Zones.txt and Codes.txt files will work for both APRS+SA and 
APRSdos. Zones.txt includes the Marine Zones. And if you want to rebuild 
the Zones.txt and Codes.txt index on the fly without stopping APRS+SA, you 
can use the following APRS+SA Calculator "trick" which expunges from 
memory the current Zones and Codes Index variable. It will be rebuild 
automatically next time it is needed using the new Zones and Codes files. 
 
#ex 'ZC_INDEX' 
 
WinAPRS and APRS+SA support these shape files. Other APRS software may 
also. Please contact the author of your APRS software regarding how to 
update these files. 
 
The files needed are the Zone Forecast Areas, and AWIPS Counties, not the 
County Warning Areas. Here are the links to the current Zone and Code 
files used by APRS+SA. 
 
http://isl715.nws.noaa.gov/mapdata/newcat/amdc/wsom/z_16mr02.zip ; 
(current file format: z_(current file date).zip 
 
http://isl715.nws.noaa.gov/mapdata/newcat/amdc/county/c_22mr02.zip ; 
(current file format: c_(current file date).zip 
 
APRS+SA can still draw warning areas using circles centered on the 
various regions with a radius the covers the area.  The files for this 
data are the same ones that I produced for use with APRSdos named 
Codes.txt and Zones.exe. This are automatically installed into the NWS 
directory when you run the APRS+SA SETUP.EXE program. Note: when 
APRS+SA first uses either the Shapefiles or the Codes/Zones files, it 
much first calculate the indexes. This may cause the program to pause 
momentarily while the indexes are calculated.  They are calculated 
only once after starting the program. 
 
Menu Button:  Use Boxes instead of Outlines from Shapefiles - If you are 
using the NWS Shapefiles, you can generate a rectangle the covers the area 
of warning instead of outlining the specific zone and code areas. You 
would use this option for speed only. 
 
Menu Button: Text to Speech - This tells APRS+SA to use Microsoft's Agent 
to speak out the warning message. 
 
Menu Button: Morse Code - This tells APRS+SA to generate a Morse code 
message of the PID code for decoded messages. 
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Menu Button: Map All Incoming packet on the Overlay - This option causes 
APRS+SA to include all decoded Zones and Codes in the NWS Overlay map. 
 
Menu Button: Recalculate Overlay - This causes APRS+SA to recalculate the 
Overlay map data for the all the messages received.  You might use this 
option if you change which files you are using, Shapefiles or not, or 
whether you change from drawing Boxes to Outlines. 
 
Menu Button: Map Overlay - this causes APRS+SA to draw a map with the 
current NWS Overlay Map data 
 
Menu Button: Clear Page - this clears the entire NWS tab, it does not 
clear the current overlay 
 
Menu Button: Clear Overlay - this clears the current NWS Overlay map data, 
but does not clear the NWS tab. 
 
Zones/Codes: In this slot, you can enter the various codes and zones you 
want to decode.  You can use Wildcards, and you can multiple 
specifications separated by either a space or a comma.  Example:  CA* AZ* 
NV*.  This would decode all messages for Zones and Codes in California, 
Arizona and Nevada.  When a packet is decoded which passes the 
specification you provide, APRS+SA will 1) Draw a map centered on the area 
of warning, 2) will generate a audio, Text-to-Speech message is Speech is 
enabled, and 3) will generate a Morse code message for the PID if Morse is 
enabled.  Decoded packets are added to the NWS Map Overlay. 
 
Mapping note: to get all of the mapped Zones and Codes to be included in 
view, check the "Zoom Includes Tracks" option on the APRS tab in the 
appropriate MOP file for the map being drawn. If you do not use MOP files, 
then the default MapOptions.MOP is used, and you can check the Zoom option 
on the APRS tab of the MOP window. 
 
Thanks to Pete Loveall, AE5PL for providing information on the NWS 
Shapefiles and NWS Message format.  Thanks to Dale Huguley, KG5QD for the 
NWS Server data.  And to Hasan Schiers, N0AN for his hours of testing and 
feedback. 
 
 
 
LIMITING WEATHER VIEWS 
 
How to the view on the NWS tab 
 
The NWS tab displays all NWS data. There is not option to turn that off. 
You can sort the list quickly however by clicking column headings. You do 
that for California for example, but clicking the Zones/Codes column, and 
then scrolling to the CA_ values. 
 
The Zones/Codes selected affect mapping and audible alarms. But all NWS 
data is collected and you can quickly add the additional data to the map 
if desired. But again, there is not option to not collect that data. 
 
 
RESTRICTING WEATHER WARNINGS 
 
To restrict the incoming internet data to the program to just display 
weather warnings that effect your area, do the following: 
 
Put the Zone and County codes that you are looking for in the "Zones/Codes" 
area of the NWS tab. For instance, Place "TX_C085 TX_Z104" without the quotes 
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in "Zones/Codes" so all that are displayed are alerts for Collin County, 
Texas. I could have used "TX_C* TX_Z*" to get all Texas alerts.  If you want 
to restrict your map updates, as well, make sure that "Map all incoming 
packets on the overlay" is not checked. 
 
Click on Setup -> Settings 
 
 
 
CHANGING NWS FEATURES 
 
Under the NWS tab you can select several items and change 
their function.  From the settings.rtf document included with the 
latest versions you will find the following text: 
 
NWS 
CodeFile, name of the NWS Shapefile used for Codes 
ZoneFile, name of the NWS Shapefile used for Zones 
MarineFile, name of the NWS Shapefile used for Marine warnings 
Shapefiles, turns on or off the use of Shapefiles 
Boxes, uses shapefiles, but draws boxes around the zone or code instead 
of outlines 
TTS, use Text-to-Speech to announce incoming warnings 
WaveSound, play wave files with same name as warning type. 
Example:  FLOOD.WAV for FLOOD warning. 
Morse, use Morse code to announce incoming warnings 
MorseSpeed, sets the speed of the generated morse code, valid values 
(0.02 -  0.12) 
MorsePitch, sets the pitch in Hz for the generated Morse code (200-1200) 
MorseVolume, sets the volume of the generated Morse code (0-127) Enabled, 
turns on or off the decoding of NWS warnings. OverlayAll, turns on or off 
the decoding of all NWS warnings, not just the currently selected codes and 
zones 
 
 
Changing the Enabled value from 1 to 0 will shut off all decoding 
of the NWS messages. Go to your NWS tab under MENU and click 
on clear page and clear overlay. Your NWS will stay empty and the 
map overlay will not contain any red or yellow NWS weather watch 
circles. 
 
Some of the keys in the settings can also be changed by clicking on the 
MENU button on the NWS tab. 
 
Your yellow and red circles come from the NWS settings and from the 
settings under the MENU button on the NWS tabs. 
 
 
 
GATING WEATHER WARNINGS 
 
TO gate those warnings to local rf, find the CWA for your area (in our case, 
North Texas is served by FWD) and put that CWA in your Gate to RF area of 
your Lists Setup. On my IGate, I have "FWD*" (without the quotes) in my 
Gate to RF list. The asterisk is a wildcard that allows any message from 
your CWA to be gated. 
 
 
 
PLAYING WEATHER WARNING .WAV FILES 
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To play a wave file for the NWS Warning Type.  Example, if a NWS warning 
was received which was "FLOOD", APRS+SA would look for the file 
WAV\FLOOD.WAV and play it if Wave files for NWS were enabled. 
 
 
 
LOCAL TACTICAL CALLSIGNS 
 
To assign a tactical callsign to someone so that there is only local display 
of the tactical information for them (without them having to do anything),i.e. 
to change the display of a call sign on just the map without changing 
anything in a tracker, tnc, remote equipment, software, etc... 
 
For your computer only; it isn't sent out to anyone else. You get the 
Tactical Callsign window by entering " T", put the cursor on the empty 
callsign=tactical entry box, enter text in the following syntax: 
 
callsign=tac_call 
 
Press keyboard <Enter> key 
 
Example: 
 
WA4HEI=SAG4 
 
Press keyboard <Enter> key 
 
 
Clearing Tactical Calls List 
 
You have to hit the clear button. Then, to confirm that you really want 
to do this, put the cursor on Yes, in the new pop-up dialog box, and 
click left, once. The list is gone. 
 
Clearing Individual Calls 
 
High-light the desired call with the cursor and one left mouse click, 
then left double click erases it. 
 
 
 
REMOTE TACTICAL CALLSIGNS 
 
Also, you can add stations to other APRS+SA stations by sending an APRS 
message to TACTICAL.  In the message text, put: WA4HEI=Pete Or for multiple 
stations, enter: WA4HEI=Pete;WB2BOL=HAWK 
 
Note also, you can send messages TO the Tactical callsign, and APRS+SA 
will substitute the real callsign.  If WA4HEI=Pete is in your Tactical 
list, when you put Pete in the TO field of the Message window, it will 
generate a message addressed to WA4HEI. 
 
 
 
GRID SQUARES & LAT LONG CALCULATOR 
 
Setup > Main > Latitude Longitude button enables the Co-ordinate 
Conversion and Map Capture utility that simplifies much conversion 
math. 
 
APRS+SA's "Calculator" can calculate Maidenhead coordinates (Grid 
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Squares), both forward and reverse. CommandsActivate the APRS+SA "Calculator" 
from the  Menu. 
 
16 character Grid Squares now supported in Coordinate Conversion calculator. 
This should give about 0.00001 degree accuracy to the grid value.  Yes, Grid 
Squares can be more then 6 characters! 
 
To Calculate the Grid Square from Longitude/Latitude, uses the following 
syntax: 
 
# GridSq lat, long   <Enter> 
 
where # is an even number, between 2 and 16, of grid square characters 
desired, lat is the Latitude in decimal degrees, and long is the Longitude 
in decimal degrees.  <Enter> Depress "Enter" key 
 
Examples; (6 is default): 
 
GridSq 34, -117 
DM14MA 
 
10 GridSq 34, -117 
DM14MA00AA 
 
 
To calculate the Lat/Long from the Grid Square, use the syntax: 
 
GridSq 'gridsq' 
 
where 'gridsq' is the group of grid square characters.  Example: 
 
GridSq 'DM14MA' 
34 ¯117 
 
Note - There is nothing magical about using 6 characters for the Grid 
Square. It can easily be extended. In fact, the Trimble ScoutMaster GPS 
receiver would report extended Maidenhead coordinates. APRS+SA's Grid 
Square function can calculate these extended values, up to 14 characters! 
 
14 GridSq 34,-117 
DM14MA00AA00AA 
 
GridSq 'DM14MA00AA00AA' 
34 ¯117 
 
Or, a more meaningful value of Lat/Long: 
 
14 GridSq 34.02345,-117.1575 
DM14KA15CP40AR 
 
GridSq 'DM14KA15CP40AR' 
34.0234498 ¯117.1575 
 
 
 
DATA LOGGING 
 
There are several types of logging of TNC data you can perform. First, 
you can log all input from the TNC. This is activated from the main 
program window, File menu, "Start Logging TNC Data". Next, you can save 
received and decoded packets. This is done in 2 possible forms. One is 
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in the APRS+SA internal data format. These can be quickly loaded at a 
future date for review. NOTE: The time filter, and auto data deletion 
functions will hide and/or remove the data. So when reviewing old data, 
turn off auto-data deletion. You can also save the received position 
packets in their raw TNC data format if you are saving the original packet 
(Position tab of Setup, upper right, "Store original packet with posits". 
These can then be saved as a text file. See the data type in the Save 
dialog box on the History tab. 
 
 
 
CALCULATOR VIEWING OF ARCHIVED TIMESTAMPED PACKETS 
 
First, the Packet Archiver is not a "finished" product.  What it does, 
is store every packet heard on RF for recall later. It does not log 
TCP/IP packets, you have FindU for that. The Packet Archive function 
creates 2 files, PACKETSYYYYWW.pkt and PACKETSYYYYWW.idx.  YYYY is 
the year, WW is the week of the year.  For example, for July 21, 2000, 
we are in week 29 so the files would be named PACKETS200029. 
 
You can start storing data by clicking the Commands > Start Packet 
Archiver. The command does not toggle. 
 
or, for auto archiving at program start: Setup > Lists > Archive : turns 
on or off Packet Archiving, 0 or 1. 
 
To recall the data open the Query Window, select Commands>Calculator to 
start the APRS+SA "Calculator". Enter the following, CASE IS IMPORTANT 
 
ArchiveForm 'Create' 
 
This will create a query form with several edit boxes on it, and an OK 
button if the form window is maximized sufficiently. The first editbox 
is for entering the callsign of the packets of interest. You can also 
enter the packet type in the second edit entry (NB! Text search is not 
implemented.) For example, enter, CASE SENSITIVE! : 
 
WA4HEI gets all packets with "WA4HEI" 
digi retrieves all packets with "digi" 
$ recalls NMEA strings 
@ for timed Position reports 
: will recall all message type packets. 
$=@!: will recall the multiple types requested 
Leave it blank, and you get everything 
 
There are other functions, again not to expose to the end user in any 
convenient way.  If you open a file from the ArchiveForm (Query Window), 
go back to the "Calculator" and enter the following; case sensitive: 
 
ALookup 'Stats' 
 
This will return the number of bytes, average bytes per packet and a few 
other items. 
 
Other ALookup commands are: 
ALookup 'Count' 
ALookup 'Calls' 
ALookup 'Types' 
ALookup 'FileTime' 
 
Again - this is all experimental, and my be altered or removed in a future 

Page 48 of 68APRS+SA, APRSPLUS, APRS+ Help File

11/20/02http://www.manistique.org/main/APRS/APRS+SAhelp.html



release. 
 
 
 
APRSERVE.TXT 
 
An APRSPLUS trick. Double click on the "Server" label on the 
Setup - Internet dialog. It opens the text file of servers for 
easy editing. Comment out, with semicolons ";", the ones you aren't 
currently using. Add a new server with the name and port, in the format 
 
hostname:port 
 
examples: 
 
localhost:3131 
www.aprs.net:23 
 
Most of the pull down lists related to configuration files behave 
similarly. 
 
If no TCP/IP data is received for 60 seconds, APRSPLUS will disconnect 
from and immediately try to reconnect to the same host, or connect to 
the next host address (if there is one) in the aprserver.net file. 
 
 
 
HEARD WITHIN X DIGIPEATER HOPS 
 
Internet to RF. If your IGate has heard an RF station within X hops (X<=3) 
in the last Y hours and someone on the Internet side has a message for 
him, APRS+ will reverse gate it. ALL rf traffic heard will be sent 
*to* the internet - the servers will take care of dupe filtering. 
 
This setting should be <= the number of hops your station typically 
transmits.  If you hear a 3-hop station and send him a message using 1 
hop, chances are he won't get it. So if you have WIDE,WIDE set for your 
UNPROTO path, you may want to set your max to 2. Of course, your mileage 
and circumstance may vary. 
 
NOTE: The odds of a packet being received by any addressed station, in 
a "busy" network, decreases at a geometric rate, for each additional 
digipeater hop. In a busy network, a choice of three hops borders on 
deliberate QRM. 
 
WIDEn-n is calculated into the number of Hops. 
 
"Heard within X digipeater Hops" means if you set it to 0 then it 
would only be passed on to rf from the internet if only the receiving 
Igate heard it, directly. 
 
"Heard within Y hours" means if you set it to 8, it would pass the 
message to the station if it was heard within the last 8 hours and 
also if it passed the X hops test. 
 
 
 
REVERSE IGATE FEATURES 
 
In accordance with those calls and icons specified in the 
Setup > Lists > Gate Callsign, and Icon lists, APRS data can be 
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reverse IGated, from the internet to the rf network. This allows for 
listed stations, anywhere on the internet or some distant part of 
the rf network, to be heard on the local rf network. 
 
You could, for example, include your mobile tracker call in the 
Callsign list, and be driving around in another state with your APRS 
data broadcast on your home rf network. You could exchange rf 
messages, at your distant location, with folks on your hometown 
rf network. I suspect, for those interested in telemetry, even greater 
challenges are apparent. 
 
 
 
REVERSE IGATING NWS WEATHER WARNINGS 
 
To reverse-IGate NWS warnings for ONLY your location 
 
You need to know the weather service stations for your area. Example, for 
SoCal, LAX is in the ID of the weather service in Los Angeles. So I enter 
LAX* in the Gate by Callsign list. New Mexico might be ABX*, etc... 
 
 
 
IGATE SUBSTITUTED TEXT TAGS 
 
Substituted Text tags are allowed in Status Text, Posit Text and 
Auto-Reply Text. For a list of tags, and their meaning, see 
SubText.TXT.  Example:  The Tag <GS6> would be substituted with the 6- 
character Grid Square.  Thus, where <GS6> is entered, it would be 
substituted with DM14KA for my home station.  Uses: IGate can indicate 
its status by entering the appropriate combinations of text and tags. 
 
The replaceable tags are Substituted by the appropriate value, when 
transmitted. For example, the tag for the IGate is <IGATE2>. On transmit, 
the <IGATE2> tag is changed to either Yes or No depending on whether the 
IGate is enabled or not; so putting something like this in your Posit text 
or Status text would show the IGate status. IGate=<IGATE2>, in the allowed 
text, would be transmitted as either: IGate=Yes  or IGate=No, depending on 
the active configuration. 
 
Example: "IGate is <IGATE2>". If the gate is open, the transmitted 
text would be "IGate is UP". 
 
Recommendation: Place important information and tags in the first 20 
characters of the POSITION COMMENT text so that users with Kenwood D7's 
can see them. 
 
Variable    Value           Meaning 
--------    -----           ------- 
<IGATE>     No\Yes          Is IGate open and available 
<IGATE2>    Down\Up         Is IGate open and available 
<FILLER>    No\Yes          Is Channel Filler on 
<INET>      Unknown\No\Yes  Is an Internet Connection Available 
                            (Win95/98= Yes/No)  WinNT=Unknown 
<VER>       ###XX           Version of APRS+SA 
<TTS>       No\Yes          Is Text-To-Speak Enabled 
<SA>        SAx             Version of Street Atlas being used 
<TNC>       Name.tnc        TNC file in use 
<UP>        Days:hr:min:sec Time since program was last restarted 
<WWW>       No\Yes          Is Web Server enabled 
<URL>       Web Address     URL of APRS+SA Web server if enabled 
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<UNIQUE>    9999            Number of Unique stations with Position 
<POSITS>    9999            Current number of unique position reports 
<TAC>       Tac Call        Tactical Callsign 
<EMAIL>     Email Address   Email address as entered on the Profile page 
                                  of Setup 
<NAME>      Name            Name as entered on Profile page of Setup 
<HOMEPAGE>  Web Address     Web Address as entered on Profile page of 
                                  Setup 
<GS4>       Grid Square     Grid Square - 4 character 
<GS6>       Grid Square     Grid Square - 6 character 
<GS8>       Grid Square     Grid Square - 8 character 
<GS10>      Grid Square     Grid Square - 10 character 
<GS12>      Grid Square     Grid Square - 12 character 
<GS14>      Grid Square     Grid Square - 14 character 
 
ECHO - TAG SUBSTITUTION AND REQUEST MESSAGE. 
 
Send a message to an APRS+SA station, and enter in the message text: 
ECHO:<TAG><TAG>...  where <TAG> is any of the valid Text Substitution 
tags. Tags can be combined with any combination of text and tags.  Note, 
returned message will be truncated to 56 characters. If the text is 
longer then 56 characters, the trailing characters are elided and 
substituted with "...". 
 
 
 
IGATE SELECTIVE CALL SIGNS, WX REPORTS 
 
To selectively gate some call signs or weather reports from the 
internet to RF (specifically to VHF, and NOT HF), you enter the 
call signs in the Gate by Callsign List on the Lists page. And check 
the checkbox at the top of the list to enable it. 
 
 
 
TRANSFERRING WAYPOINTS TO A GPS RECEIVER 
 
Support for NMEA transfer of waypoints to a GPS receiver connected 
via Port 2 of APRS+SA. The program will create waypoints in $GPWPL format 
for position reports, and send them to the GPS if the port is open.  The 
selection of the reports to send currently has 3 methods. All, Tracked 
Stations, and stations selected to be displayed in the History tab.  Note, 
wildcards are supported in the selection of stations. Selecting All and 
using the Internet feed is probably not a wise choice, but I'll leave it 
up to you. See Settings.RTF for options on the new GPS section of 
Settings. $GPWPL sentences can be generated from the Position, Position2, 
History, Weather, and IGates tabs.  Right click on the selected station or 
stations, and choose, "Send to NMEA GPS". 
 
 
 
MAPPING INTO MAPSOURCE 
 
Highly Experimental: Mapping into MapSource. MapSource is from Garmin 
for the Mapping GPS receivers. In the release, I have added a couple of 
experimental maps. You enable these options on the MPS section of 
Settings. 1) Tracking.  You can enable mapping of position reports into 
MapSource.  If you have Zoom Most Recent on (see Tracking tab), then it 
will only map the report that was just received.  If you have Zoom Most 
Recent Off, them that map is similar to the stations on Map 4 of Maps. 
And Clicking the Map 4 button will cause MapSourse to be populated with 
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the most recent position for stations in the Tracking list. The other 
option is Mapping ALL reports, similar to Map 2 of the Maps tab. WARNING: 
Do not enable Zooms on MapSourse if you have other programs open that use 
Ctrl-D to Delete data. You may loose data in those program if you switch 
the focus to those program when MapSource is being updated by APRS+SA 
/WARNING:  NOTE: this is all experimental, and ! may be removed at any 
time.  /NOTE:.  Notes on MapSource - MapSource Roads and Recreation maps are 
similar to Street Atlas USA as far a street placement.  MapSource 
Metroguides are very good maps, and appear to be more current then either 
R&R or SA. There is also a World map available, and a number of European 
R&R and MG maps. Also, Topo maps for the US. The program Trackpoint+ 
supports MapSource and SA maps also, if you want to try just an APRS 
mapping program 
 
 
 
PROXY SERVERS 
 
There are several different kinds of proxy servers. On the Internet tab 
of Setup, you enter your proxy's address, and the address of APRServe in 
the "server" slot.  Click connect.  APRS+SA will first connect to the 
proxy, then issue a connect command to APRServe. This configuration works 
in a number of locations.  If this does not work, click the Manual 
checkbox next to the Proxy, and click connect, go to the TCP tab of the 
main server, and enter the appropriate commands to connect to APRServe, 
for you proxy.  Once connected to APRServe, click the APRServe button to 
validate you station. Yes, manual is a bit of a pain.   Brent KH2Z 
 
 
 
KISS, KipSS/PE, AND KipSS 
 
 
KipSS/PE TO AGWPE 
 
The program, KipSS/PE uses the Kiss over IP interface and talks to 
the AGWPE. KipSS/PE works just like KipSS, except the KipSS/PE talks to 
the AGWPE while KipSS talks to a TNC. 
 
You need to download the file, KipSS/PE.zip at: 
 
ftp://ftp.tapr.org/aprssig/winstuff/aprsplus 
 
The SV2AGW Packet Engine and supporting documentationlinks are at the 
beginning of this document subject material. 
 
Install and configure the AGWPE files in their own directory. 
 
In AGWPE's WinSock and HTTP Interface Setup window, leave the TCP port # 
at the default 8000, unless you understand the setup better than I do. 
 
You should start, and configure  AGWPE first, then run the program 
KipSS/PE.EXE. 
 
In the KipSS/PE window there is a dialog box for Settings; ignore it, it is 
not used at this time, unless you understand the setup better than I do. 
 
N.B.!!! KipSS/PE ALWAYS (to date) assumes that the PE will be at 127.0.0.1 
on port 8000 so to change the Settings data actually accomplishes nothing, 
except to create input dialog with an expectation that it will do something. 
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Click "PE Open" button. Button will change to "PE Close". 
 
Next, there is an IP address selection. It should show all valid IP addresses 
for your computer. KipSS/PE uses port 7301, as default, so select the 
appropriate IP address, and do not add a port number, unless you understand 
the setup better than I do. 
 
Click "Open TCP/IP"button. Button will change to "Close TCP/IP" 
 
On APRS+, connect to KipSS/PE from the KipSS section on the Internet tab of 
Setup. Enter the IP Address that you are using in KipSS/PE, without a port 
number. Port 7301 is the assumed default; do not add a port number, unless 
you understand the setup better than I do. 
 
Back on KipSS/PE, you can check the Auto-Start checkbox. 
 
Exit KipSS/PE. 
 
When you start KipSS/PE next time, it will automatically connect to the 
PE, and open the TCP/IP port for client programs. 
 
APRS+SA will automatically connect to KipSS/PE, when you start APRS+. This 
assumes you start AGWPE first, then KipSS/PE, then APRS+SA. 
 
KipSS/PE works and acts like KipSS. The KipSS/PE icon will appear in the 
System Tray once started. The Icon is the letters K I S S in Morse code. 
 
Hitting the Esc key or [X] will hide the KipSS/PE window. Click on the 
KipSS icon to bring the window back. There is no button on the task bar. 
The way to close the program is by clicking on the Exit menu. 
 
If APRS+SA is not receiving data via the KipSS interface in 120 seconds, 
i.e. if you are on a quiet RF network, you will get a reconnect to KipSS 
every 120 seconds, on the TNC page, if nothing has been received. 
 
NOTE: If you understand how and why to shuffle the various port options, 
      of the various pieces of software, in this integrated setup, I 
      would like to know, and include it in this documentation. 
 
      I spent many hours trying to make sense of it, and failed. Using the 
      port defaults, as described, resulted in a working and stable 
      configuration for me, WA4HEI. 
 
 
 
AUTOMATING STARTUP OF APRS+SA WITH AGWPE 
 
Automate the Entire Startup Process via the AGWPE.INI file 
 
Want to get the AGWPE program to automatically start KipSSPE and 
then APRSplus and Radio Mobile when AGWPE finishes loading? Here's how: 
 
Locate the file AGWPE.INI in the AGWPE program directory. 
Open the file in the Windows Notepad or any other ASCII editor and 
add the following paragraph to the bottom of the file: 
 
[RUNPRG] 
RUN0=D:\Amateur\APRSPLUS\KipSSPE.exe 
CMD0=0 
RUN1=D:\Amateur\APRSPLUS\APRSplus.EXE 
CMD1=0 
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RUN2=D:\Amateur\Radio Mobile\RMWDLX.exe 
CMD2=0 
 
Note: Be sure to edit the file paths in the paragraph to match the drive and 
directory where you have installed the KipSSPE and APRSplus programs. 
Then save the file and close the editor. This automated process will 
begin the next time you start AGWPE. 
 
 
 
AUTO STARTUP OF APRS+SA FROM MULTIPLE AGWPE.INI FILES USING VBScriptfiles 
OR BATCH FILES 
 
>Windows Scripting Host has to be installed to run scriptfiles. Since the 
>appearance of script-viruses one should be very careful when the Scripting 
>Host is installed, especially when using Outlook Express. 
 
Anyone with anything like a recent version of IE installed will already 
have the Windows Scripting Host (WSH) installed. In my experience it is 
now unusual to find a PC that hasn't got it installed. If WSCRIPT.EXE is 
in your WINDOWS, WINDOWS/SYSTEM or WINDOWS/SYSTEM32 folder, then WSH is 
installed on your PC. 
 
As regards security issues with WSH or any other aspect of Windows, one 
thing every Windows user should do as a matter of routine, particularly 
if they use Outlook Express, is to go to the Windows Update page - 
http://windowsupdate.microsoft.com/ - and install any available critical 
updates. 
 
-- 
Roger Barker, G4IDE - http://groups.yahoo.com/group/SV2AGW 
 
To be able to choose from differently configured AGWPE.INI files, how 
about using a good old DOS batch file? Or, if you want to be a bit more 
modern, a VBScript? 
 
Batch file - Put the following two lines in Option1.BAT, and save it in 
in your AGWPE folder. 
 
COPY AGWPE1.INI AGWPE.INI 
"AGW Packet Engine.exe" 
 
Then make another one called Option2.BAT that copies AGWPE2.INI, etc... 
 
VBScript - Put the following four lines in Option1.VBS, and save it in 
in your AGWPE folder. 
 
set fso = CreateObject("Scripting.FileSystemObject") 
set sh = CreateObject("WScript.Shell") 
fso.CopyFile "agwpe1.ini", "agwpe.ini" 
sh.run """AGW Packet Engine.exe""" 
 
(Note - there are three sets of double quotes surrounding the file 
name.) 
 
Then make another one called Option2.VBS that copies AGWPE2.INI, etc... 
 
Create a separate shortcut to each VBScript, and name it to reflect its 
unique purpose. A double left mouse click, on each shortcut, will then 
start AGWPE according to the parameters stored in the particular 
AGWPE.INI file identified in the VBScript associated with the shortcut. 
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-- 
Roger Barker, G4IDE - http://groups.yahoo.com/group/SV2AGW 
 
 
 
SETTING UP APRSPLUS FOR 2 TNCs 
 
There isn't provision for a 2nd TNC. Only a single dual-port such as a 
KAM or KPC-4. 
 
You can use more than 1 TNC, indirectly, by installing AGW Packet Engine 
which can deal with multiple hardware TNCs as well as the soundcard soft 
TNC. 
 
Then install the APRSplus add-on middleware KipSS/PE which then attaches 
AGWPE to APRSplus as a quasi-Internet connection. The KipSS/PE interface 
is activated on the Internet tab of the pulldown Setup screen. For more 
information, see the  web site: 
 
http://www.qsl.net/soundcardpacket/ 
 
or get the capture of this site into an Acrobat .PDF file located at 
website: 
 
http://members.aol.com/wa8lmf/links 
 
Note that: 
1) When you go to the APRSplus FTP site, be sure you are downloading 
   KipSSpe, not the  similar-named KipSS file ! 
 
2) The KipSSpe interface only works with REGISTERED copies of APRSplus! 
 
 
 
APRS+SA KipSS Password 
 
You can't change it. KipSS has two login methods. Initially, it was an 
internal hashed number that was created based on your call sign. Your call 
sign and the number is sent to KipSS which then verifies it is correct, and 
validates it. The alternate method is the Password you define in KipSS. 
Then the logon sequence is \CALLSIGN\PASSWORD. Note: KipSS and KipSS/PE are 
2 quite different programs, and the above discussion pertains to KipSS. 
 
 
 
KISS SETUP - KipSS - FOR LAN OPERATION 
 
KipSS.  KipSS is a program that allows KISS of IP.  This makes an 
ideal interface for working over a network, either local or remote 
over the Internet.  For information about KipSS, see: 
 
ftp://ftp.tapr.org/aprssig/winstuff/aprsplus 
 
See the file KipSS.htm or KipSS.zip. KipSS runs in conjunction with 
APRSPLUS.EXE found in APRS+1.zip at the same FTP location. With KipSS, 
multiple copies of APRS+SA can share a TNC. APRS+SA can be run on 
multiple computers. 
 
Do note, that Kiss mode from either APRS+SA or KipSS uses completely 
different code to communicate with the serial port then what is used when 
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you open either Port 1 or Port 2 on the Main tab of Setup.  Kiss is using 
the MSCOMM32.OCX ActiveX communications control.  The proper way to setup 
Kiss or KipSS is to do the following: 
1) Enter the appropriate communications parameters in the Setup> slot. 
2) The second slot contains the commands to put your TNC into Kiss mode. 
   As an example, for a KPC-3, I enter: INT KISS (CR) RESET (CR) 
 
Note the (CR) sequence is replaced by a carriage return character when 
actually sent to the TNC. 
 
3) Click the Open button.  If it opens the serial port properly, the Open 
changes to Close. 
4) Click the Kiss On button.  It should change to Kiss Off. 
 
There are 2 Transmit buttons next to 2 Demo> slots.  In the Demo slots, 
you can enter complete packets, in TAPR2 format in order to test the Kiss 
interface.  The packet contains the Path, a port assignment, and the 
packet data payload.  Example: WA4HEI>APRS/1:This is a test This would 
transmit a packet from WA4HEI, to APRS, on Port 1.  The payload is "This is 
a test".  If you have a single port TNC, and have entered /2, your TNC 
will probably not transmit. 
 
The Transmitted Data slot shows the complete packet that was attempted to 
be transmitted.  If you TNC is not transmitting, check which port, if any, 
was being selected. 
 
The Received Data slot shows packets successfully decoded on receive. 
 
KipSS allows a list of KipSS nodes in the Kipss.txt file.  The color 
":" is the separator for the data in this file. The basic form is for 
data entry into the Kipss.txt file is as follows: station 
identifier:IP address:IP Port.  Examples: 
 
Redlands Node:209.145.3.45:7301 
Redlands Node Also:wa4hei.whiner.com:7301 
 
 
Alternative 
 
If several PCs are being networked with TCP/IP protocol,native mode 
of Win98, 2K, and later; BUT not native to Win95 (which as to be 
installed as an add-on), you can use AGW on ONE pc with a radio attached 
to the soundcard. Since AGW ( and for that matter, most APRS apps) acts 
as an IP server, you can then set the APRS applications on the other 
PCs to connect via "Internet" instead of via the TNC port. Determine the 
IP address of the sound card "server" PC on your LAN,  and  then set 
that address into the IP address box of the APRS apps running on the 
other machines instead of the "real" aprs.net address. 
 
 
Alternative 
 
KipSS will work fine under Win2K. 
 
Copy the KipSS files into their own directory (not APRS+SA's directory). 
Exit APRS+SA. Run KipSS. Define callsign and alias (I use RELAY). Select 
TNC port and select autostart. 
 
KipSS requires a TNC that can operate in KISS mode. It will set the TNC 
to KISS mode and you should start seeing RF data showing in the receive 
window. 
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With KipSS running, start APRS+SA and go to setup. Turn off the TNC 
port. Go to the Internet Tab.  In the bottom right of that setup screen 
is a KipSS Open button and a text field. Enter the IP address of the PC 
(127.0.0.1 if APRS+SA is on the same PC) and port number (7301). It will 
look like 127.0.0.1:7301 
 
You can create a file with this info in it. In your APRS+SA data 
directory, create a file called "KipSS.txt" (without the quotes). Enter a 
line that looks like: TNC Name:IP Address:Port The IP Address can be a DNS 
name or a physical IP address. The Port is 7301. 
 
Hope this gets you closer. The password is only needed for non-APRS+ 
applications. 
 
 
Alternative 
 
I run KipSS on the computer with the TNC (download from the APRS+SA 
directory on TAPR). I run APRSPlus on that TNC as my RF Only view and as 
an APRS weather station. I run APRSPlus on a different server as an 
IGate. Both APRSPluses talk to the RF world via the single TNC 
 
 
 
KIPSS WITH TWO LAN COMPUTERS ON ONE TNC 
 
Set 2 IP addresses in KipSS, one 127.0.0.1 and the other the LAN IP of 
your KipSS PC. Have APRS+SA connect to KipSS via the KipSS box on the 
Internet Setup using 127.0.01:7301 for the local and LANIP:7301 for the 
remote where LANIP is the IP address of the KipSS PC. KipSS should be 
set to use all defined IP addresses. 
 
 
 
SEEU FOR FINDU 
 
17 Jun 2000 23:40:54 
 
I have posted the file, SeeU.zip at TAPR's FTP site.  See: 
 
ftp://ftp.tapr.org/aprssig/winstuff/aprsplus. 
 
SeeU uses SQL lookup to FindU's database, and takes the data and plots it 
into Street Atlas USA. 
It should work with version SA4,5,6, and 7. There are 2 lookup modes: 
1) Latest Known Position 
2) Track data. 
 
Track data is limited to 100 position points in the last 24 hours. 
Latest Position is the last known position for your chosen station. 
 
Setup instructions, download the SeeU.zip and unzip the contents to a new 
directory. Double click on SeeU.exe and the program should start. 
 
There are 4 menu options. 
1) Connect - makes or breaks connection to FindU. 
2) Lookup - performs the lookup of position data.  You must connect to 
FindU first. 3) Options - Sets various display options for Street Atlas. 
NOTE: APRS tab is NOT used. 4) View - View the data you have downloaded in 
the Lookup 
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How to do a Lookup: 
1) You must have an active Internet connection. Sorry, no proxies. 
2) Start Street Atlas USA. NOTE: the program defaults to SA7. If you 
   are using a different version, you much change it by selecting the 
   Options menu, then the Map Features tab, and set the SA Version. 
3) Connect. Click connect to connect to FindU. The status bar will show 
   you progress as the connection proceeds, finally showing you "Ready for 
   Lookup" 
4) Enter the call sign of the station you want to locate. 
5) Click Lookup which has 2 options 
    a) Track Data which is limited to the last 24 hours and only the last 
    100 points in the time frame. NOTE: This can time some time!!  You 
    need to be patient with this option 
    b) Last Known Position will show you the last known position for a 
    station. This is generally very quick. 
 
Map display - The track map will show the track, if any and the call sign 
of the station, followed by the time since the position was heard. 
Example: KH2Z (0:0:1:34) Meaning:  0 days, 0 hours 1 minute 34 seconds The 
Last Known Position will show the call sign and the time with a dot at the 
location of the station. 
 
This is the first release of this program. I have not tested it on any 
platform other then Win98. It is supplied AS IS. There is no guarantee 
made of any kind. Use this program at your own risk. 
 
SeeU should run Win95 (with latest updates from Microsoft), Win98, and 
WinNT/2000. Again, I have only used it on Win98. 
 
FAQ: Does it show Icons?  No. 
 
 
 
HISTORY FILES 
 
History Tab - enter the callsign(s) of the positions you want to save, 
click the Save button.  You can either save the original packets, or save 
in APRS+SA's log file format. 
 
 
 
HISTORY LIST 
 
If you draw maps, such as "Stations in Range", or "Local", or "Direct", 
the callsigns of those station will be entered into your History list. 
You can predefine any number of callsigns for the History list in the 
History.txt file. Double-click on the "Enter Callsign>" label to the 
left of the callsign list to edit the History.txt file. 
 
 
 
SAVING AND LOADING HISTORY "TRACK" FILES 
 
History Tab - From the History page, enter the callsign(s) of the 
station(s) you want. Then click the SAVE button. You can save the 
data in APRS+SA's internal format or if you are saving the original 
packets (option on the Position tab of setup), you can just save the 
original packet to a text file. 
 
To reload the previously saved data, and then generate a map from those 
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data. NB!!! When you reload, be sure that automatic data deletion is 
turned off if the data's time stamp is not within those being 
preserved on the data tab of setup, or else it will be automatically 
purged during the next cleanup! 
 
The track (and everything else APRSplus superimposes over a Street 
Atlas map) is part of a normal Street Atlas overlay file with a form 
of the type filename.SAn where n is the version of Street Atlas you 
are running; i.e. if you are running Street Atlas 8.0 these files will 
be of the form filename.SA8. 
 
 
 
SAVING STREET ATLAS DISPLAYED DATA OVERLAY FILES 
 
You can save everything on the current map by doing a File, SaveAs in 
Street Atlas and giving the overlay any name you wish. (This is an 
intrinsic feature of Street Atlas that is completely independent of 
APRS). Later on, you can start Street Atlas alone (APRSplus not 
required) and reload the overlay by doing a File, Open.  If you wish, 
you can use SA's own draw tools to annotate the overlay and then 
re save it.  When an SA overlay is saved, the current center position 
and magnification is saved along with any drawing objects (lines, 
labels, map notes, etc) so when you reload it, the map will return to 
the same position and size as when you saved it. 
 
APRSplus actually creates these overlay files "off-screen" and then makes 
SA open them (each time the map refreshes or plots a new position, the 
overlay file who's name shows in the SA title bar is being re-written). 
If you then save it under a new name before the next refresh, you have 
grabbed it for posterity... 
 
 
 
OBJECT OVERLAY FILES 
 
There is a way to add objects to SA or APRS+SA maps, and  to have them 
show on the map, each time a map is loaded. These objects (locations, 
wx, etc.) will not be transmitted, and whenever a map is drawn, 
designated objects are added to the display. 
 
This is called an Overlay. There are a several types of Overlays.  The 
global overlay is generated by the GLOBAL.SAx file  Enter your objects on 
the map in SA, and save it a file named Global, in the APRS+SA DATA 
directory. It will then be loaded automatically when a map is drawn. 
Or, you can load the objects manually from the Files menu, where you can 
open any SA map and the objects in it will become overlay objects.  And 
Each map can have it own overlay.  Save the specific overlay to a file of 
MAPNAME.SAx. 
 
 
 
MIC-E TRIGGERING PORT 2 DTR LINE FOR EXTERNAL HARDWARE 
 
Fri, 10 Nov 2000 15:54:23 -0800 
 
Experimental: Mic-E alarms now trigger the toggling of the 
DTR line of the serial port opened as Port 2 on the Main tab of Setup. 
This port is frequently used for GPS input, and the DTR line is not used 
in communications.  This line can now be used as a trigger to external 
hardware when a Mic-E alarm is received.  In addition, this can also be 
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triggered by messages sent TO ALARM, ALERT, WARNING or EMERGENCY.  The DTR 
line is raised when triggered.  To clear an alarm, used the Commands Menu. 
 Commands+Clear+Clear Alarms, or simply, Alt+C+C+C.  An addition method of 
triggering an external alarm is to send a directed message to your APRS+SA 
v1.99YF station, and using ** as the first 2 characters of the message. 
Additionally, ## will trigger a second alarm using the RTS line 
 
 
 
STREET ATLAS TOPICS 
 
RUNNING SA MAP DATA RUNTIME FILES (MAP FILES) FROM ANY DRIVE 
 
I forgot to mention that there is another completely undocumented program 
in the SA8 bundle that will let you use CD data copied to ANY location on 
your system AFTER SA8 is installed.  In the subdirectory \UTILS underneath 
the main directory where SA8 is installed, you will see an application 
OSMOSIS.EXE . Running OSMOSIS allows you to specify the location of the 
SA8 data files if they are in a location other than under the main program 
directory.  This location can be on another drive, or even another machine 
on a network using Windows UNC naming conventions; i.e. 
\\SERVERNAME\DIRECTORYNAME. 
 
To use it, copy the entire contents of the SA8 runtime (data) CD (except 
for the directory \UTIL which is not needed) into a directory such as 
\SA8data on your hard disk,  preserving the relative directory structure. 
Then run OSMOSIS and specify the entire path  to this directory, including 
the drive letter; (such as D:\SA8data) when prompted for the data 
location. 
 
Start up SA8 and test it. You have succeeded if you  can zoom into mag 12 
or closer (where the grey minor streets start showing) and see street 
detail without the CD inserted. (The Interstate and major road data is 
part of the base SA8 installation and will show even with no CD,  or no 
data extracted). 
 
 
 
EXTRACTING SPECIFIC SA FILES FROM CD TO HD 
 
I don't have my SA8 CDs handy to make sure of all the steps, but here is 
the general way to get SA8 files onto you hard disk. 
 
When you start SA8 Installation, select the "Custom" option.  One of the 
next screens will allow up to pick components - pick "Extractor" in 
addition to whatever else you want (I'm not sure right now what the 
choices are).  Extractor is the program that will allow you to load the 
files on your HD. 
 
After installation is completed, open the Programs menu and then look for 
the Delorme section. You should see Extractor as one of the Delorme 
programs. When you run Extractor, you may select just what you install 
right down to county level (I think).  For example, I only installed 
states where I generally travel. There are also some other choices, like 
Interstates. Check all of them out to see what you like. 
 
I was disappointed that Delorme did not have more on Extractor in the 
manual.  I have run several previous versions and it took me a couple of 
tries to remember how to get to it. 
 
If you have already installed SA8 without extractor, you may have to 
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completely remove it and the re-install, putting Extractor in during 
installation.  I could never figure out how to get Extractor to install 
after SA8 was already installed. 
 
 
Once things are expanded it seems to take at least 850 MB for a full 
install. There are many options for customizing the extent of the 
installation: 
 
You can elect whether or not to store points of interest info. This has 
an impact of 10's of MB, and greatly affects search speed for points of 
interest and zip codes. You should probably go for everything rather than 
a partial here. - you can select specific types of points of interest info 
to extract. This seriously slows down the extraction process and will make 
you think the computer stopped. - you can select specific geographic areas 
to extract street info from. Since I live close to CO in the SE corner of 
WY I have CO and WY loaded on HD. Anything outside of that, I need the CD 
to be present if I want close up detail. Major highways for the whole 
country always install no matter which states or counties you select on a 
partial extraction. This option affects 100's of MB of HD space. 
 
You run the Extract program that's in the same directory as your SA. 
Loading the Extractor is an install option which you might have said NO 
to. If it's not on your HD already, just run Setup again from the CD. 
 
>Also, there is mention that there is an option during install to install 
>all the files to the HD...I sure never saw it. Now...how do I go about 
>changing it. 
 
You only see that when you run Extract. 
 
>Another consideration is how will APRS+SA know to look to the HD instead 
>of at the CD? 
 
No difference whatsoever - Brent's APRS+SA looks for your Street Atlas 
*executable* by name once you tell it which version you have. Street Atlas 
in turn keeps track of where it's *data base* info is stored. 
 
 
 
RDF RADIO DIRECTION FINDING FUNCTION(S) 
 
 
APRS+SA can draw RDF Bearing lines. Press Ctrl-D to activate the DF 
window. Current position can automatically be entered, bearings are 
manually entered. Bearing lines then persist until they are deleted with 
most subsequent map redraws. 
 
 
 
TRACKPOINT+ 
 
Jan 2001 
 
Posted to the TAPR FTP site, Trackpoint+. 
See: ftp://ftp.tapr.org/aprssig/winstuff/aprsplus/Trackpoint.zip 
 
Trackpoint+ is position plotting program that utilizes either 
DeLorme's Street Atlas USA (SA)  maps or Garmin's MapSource (MPS) maps 
for the display of APRS style station location, and tracks. Both SA 
and MPS can provide street level detail maps. SA provides coverage 
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for the United States. MPS provides coverage for the United States in 
3 different style maps, including Topo style maps, and also Canada and 
many parts of Europe. 
 
Trackpoint+ decodes various position packets and APRS style status 
packets only. 
 
Trackpoint+ does not connect to a TNC directly. Input to Trackpoint+ 
is via TCP/IP.  Trackpoint+ will connect to either APRServe, AFilter, 
or KIPSS. KIPSS provides TCP/IP connectivity to a Kiss TNC, and is 
available at the above FTP site. 
 
Trackpoint+ currently is available for experimentation only. Read the 
file Trackpoint.txt in the program distribution. 
 
 
 
PEEDY - TEXT TO SPEECH TTS 
 
MS Agent is used to do Text-to-Speech (TTS). It requires at least 3 
files, The Agent software, MSAGENT.EXE, the TTS software TV_ENUA.EXE, 
and a character. Peedy seems to be a popular one. Install all three. On 
the Program tab of Setup, the is a slot to enter the character you want 
to use, if you have chosen Peedy, enter: Peedy Now if you click on the 
Speech menu, Enable, you should see Peedy "fly" on to the screen.  The Off 
Screen menu moves the agent character off screen, but you still hear it. 
What you hear depends on what you have configured the character to speak. 
This is set on the Sounds tab of Setup. At the top, there is "Tracking 
Talk>" with several options. Also, you can enable the several Speak 
options on the right.  Note, if you do not have WAV files for the other 
possible sound effects, the Agent will speak what the name of the file you 
have selected. Example, you have a selected the WAV file UPDATE.WAV to be 
played when a new Position report is received, the Agent will SPEAK the 
work UPDATE. Enabling the speaking of incoming messages means the Agent 
will speak the text of the message. 
 
Peedy will only announce positions for your tracked stations if you 
have them in your track list (otherwise he might never shut up!) Also, 
you have to have the Setup > Sounds > Top Right, check Verbose. 
 
 
 
.WAV FILES 
 
For those that may be interested in generating a complete custom set of 
.wav files, they may be generated at these web sites. I consider the Bell 
Labs pages the best. 
 
http://www.bell-labs.com/project/tts/voices.html 
http://www.bell-labs.com/project/tts/digtalk.html 
http://www.research.att.com/~ttsweb/cgi-bin/ttsdemo 
 
 
 
WEB PAGE SERVER 
 
TEMPLATES 
 
1) Templates.  These are web pages you can design to display certain text, 
data, and/ or maps the way you want. The Templates are called up from the 
Message entry window, under the Query button.  For example, you may have 

Page 62 of 68APRS+SA, APRSPLUS, APRS+ Help File

11/20/02http://www.manistique.org/main/APRS/APRS+SAhelp.html



found a location on the Internet to provides really cool maps.  You can 
build a web page using replaceable parameters that APRS+SA provides to 
build your page.  I have provides a couple of examples in Template1.htm or 
Template2.htm.  Template1.htm will draw a web page with 3 maps from 
MapBlast.  The replaceable parameters in the Templates are delimited like 
this:  #long#.  This would be replaces by the Longitude of the station you 
have entered into the Message entry windows To Callsign slot. Click the 
Query button, and choose the Internet menu option.  Note: In all prior 
versions, a connection to APRServe was required.  This restriction will be 
dropped in the next revision, because obviously, you may have an Internet 
connection without a connection to APRSer! .  Here are a list of 
replaceable parameters you can use in constructing a web page Template. 
#call#,  #blat#, and #long#.  These apply to the call sign in the Message 
entry To field.  Additional replaceable parameters include  #mylat#, 
#mylong# and #mycall# for your Latitude/Longitude and call sign. 
 
 
APRS+SA web server now has settings that can be entered into the 
SETTINGS.INI file to allow for generating Web Pages with just RF Stations, 
or all known stations.  Also some time limits are now adjustable.  The 
following are the INI file Keys for the Web Server 
 
[Web Server] 
RF=1 
PositionTime=2 
HistoryTime=2 
StatusTime=4 
 
RF=1, means, only draw stations on your local RF network.  This ignored 
IGated packets. The time values are in hours, and the defaults are shown. 
 
Web Server: Web page for specific stations now shows time since last 
position heard, and automatic reload after 3 minutes. 
 
 
 
MESSAGES, BULLETINS AND EDITING 
 
The maximum length of a message is 65 characters.  APRS+SA will split 
a message at a space character, you can just keep typing. The number 
of characters is displayed so that you can keep a message short, if 
your target station can not display the full length message. You may 
choose shorter message lengths to create shorter packet lengths that 
decrease the odds of intermittent noise spike corruption of any 
individual packet, a common lower hf phenomenon due to various forms of 
QRN. 
 
You can enter a message, and choose "Load" instead of "Send". This 
enters the message into the queue in the suspended condition. APRSPLUS 
will start transmitting the message when it hears the target station. 
In this way, you can load a suspended message to a station that is not 
on the air, but who can then receive it the next time that station is 
on the air and is recognized by your APRSPLUS program. 
 
APRS+SA will transmit an outbound message, then 8 seconds later repeat 
it, doubling the interval each time until 20 minutes and it will 
timeout.  It will try again, one time each 20 minutes if it hears the 
target station again. 
 
Note: If a station, for which a suspended message is queued, returns 
to the air with a tnc only, i.e. a compatible APRS program is not 
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operating at the target station when it returns "on the air", then, 
upon hearing the intended recipient station, the senders APRS+ 
software will try to deliver the message to a dumb tnc that will not 
"ack"nowledge reception. The message originating APRS+ program will 
continue the previously described transmit cycle. 
 
Right click to see individual or grouped message line options. 
Control+left click or shift+left click allow user to select various 
combinations of message lines. Editing and manipulation of message and 
bulletin lines is done from the message and bulletin tab pages. 
 
Editing existing message and bulletins may be initiated by double left 
clicking a queued message or bulletin on the message tab page. The 
existing "to call" will be loaded into the message dialog box, 
allowing a total rewrite, if desired of that particular message text. 
 
A single right click on a queued message brings up a message line 
menu, from which Copy Message may be chosen to load both the "to call" 
and the message text, allowing editing of both. 
 
To initiate automatic transmit control of loaded or manually suspended 
bulletin(s), you must right click > Resume Transmission. As these 
generic messages are targeted to a group of stations, they have no 
auto resume transmit option as message lines addressed to specific 
stations. 
 
Right click message line and select Queue Time: Shows time of next 
transmission, in status bar, for the particular line clicked. 
 
 
 
EXPERIMENTAL MESSAGE FUNCTIONS 
 
New message functions: one can now store and retrieve and delete data 
remotely. To use these functions, one sends an APRS message to your 
station. In the message body, use the following constructs: 
 
STO:name data goes here. 
RCL:name 
?name? 
DEL:name 
 
name is the "name" of the data being stored. Note that the construct 
?name? will also return the requested data.  ?name? and RCL:name 
return the same data, however, ?name? transmits the data only once 
while RCL:name queues the data up as a regular APRS message. 
STO/RCL/DEL are not case dependant. 
 
Example: 
STO:Jim Call home when you can 
RCL:Jim 
Jim=Call home when you can{01} 
 
These messages are stored in the DATA subdirectory with following 
naming construct:  "name.msg" This allows for the creation of any 
number of such files for recall later. 
 
Experimental: APRS+SA runs using an advanced "APL" interpreter. 
This allows for interpreting code on the fly. This release allows for 
inputting of numerical code. Send a message as in #2 above as 
follows: 
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APL:code goes here 
XEQ:code goes here 
 
Examples: 
APL:  (1+2) #time (3+4) 
Returned: 
APL=21{02} 
APL:  GridSq 34,-117 
Returned: 
APL=DM14MA{03} 
 
This is experimental. 
 
 
 
REPLY/ACKS - ACKNOWLEDGEMENTS 
 
Reply/Acks have message "acks" encoded in the APRS message line 
number. This is an attempt to increase message through put. Thus, each 
outgoing message to another station will include the message number of 
the most recently received message in an attempt to speed up the "ack" 
process. Line numbers will look like this: 
 
{AK}MN where AK is the message number to be "ack'ed", and MN is the 
Message Number of the new outgoing message. 
 
This has been implemented in v1.99XN to be transparent with the 
current APRS messaging system. This is experimental, and will only 
work fully between other stations that support reply/acks. 
 
 
 
SMART BEACONS 
 
Normally position reports are transmitted at time intervals determined by 
the number in the pulldown to the right of the "Posit Text" window 
 
With Smart Beaconing checked, the rate of position reporting  varies based 
on your speed as reported from an attached GPS receiver; i.e. if you are 
moving rapidly (GPS position is changing rapidly) it sends position 
reports more frequently. If you stop moving, position reports are sent 
much less frequently to reduce channel congestion when there is nothing 
new to report. 
 
Variable Beaconing for moving stations based on the "Smart Beaconing" 
work of Steve Bragg and users the HamHUD.  See: 
 
http://www.qsl.net/ka9mva/hamhud 
 
To setup variable rate beaconing, press Ctrl+Shift+B or use the Commands 
menu to bring up the window to set beaconing parameters. Beacon rates 
are determined by speed and turn angle. Faster speed has faster beacon 
rates, up to a maximum of Beacon_Fast rate at Fast_Speed. Beacon rates 
will not be faster then Beacon_Fast based only on speed. When stopped, 
or at a speed less then Slow_Speed, the beacon rate becomes Beacon_Stopped. 
Beaconing can be triggered by a turn. Speed must exceed Slow_Speed for 
turning angle to cause beaconing. This is determined by 3 factors, 
Turn_Minimun, Turn_Factor and Turn_Time. See the Turn Plot for beacon 
rate based on the turn angle and speed. To have APRS+SA use variable 
rate beaconing, check the Checkbox next to the "Smart" button on Port 2, 
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main tab of Setup. This should apply whether position input is via 
Port 1 or Port 2. The "Smart" button also activates the Variable 
Beaconing parameter setup window. 
 
 
 
QRZ AND EMAIL ACTIVE X FEATURES 
 
eXtensions for APRS+SA v2.0 
 
Download APRSX.ZIP at tapr.org 
 
1) Unzip the file APRSX.ZIP into a subdirectory of your APRS+SA directory. 
 
2) Copy the files XLOOKUP.W3, XLOOKUPNAME.W3, and XSMTP.w3 to your APRS+SA 
   directory. 
 
3) Execute the SETUP.BAT file.  This will configure the file APRSX.EXE as an 
   ActiveX control. 
 
4) Edit the Email section of Settings, under Setup in APRS+SA. 
 
[Email] 
EMAIL_RETURN=you@mailhost.com 
EMAIL_HOST=mail.mailhost.com 
 
you@mailhost.com should be your return Email address, or an appropriate 
email address. 
 
mail.mailhost.com should be address of your POP3 mail host. 
 
You should now be able to send APRS Email messages and do QRZ callsign 
lookups. 
 
To send an Email message, send a message to your station's callsign and in 
the message body, put: 
 
em: someone@somewhere.com  The message subject goes here 
 
You should receive back a confirmation that the message was actually sent 
 correctly. 
 
To lookup information by callsign, send a message to your stations' 
callsign, and in the message body put: 
 
L:wa4hei 
 
You will be returned the name, license class, and address associates with 
that particular callsign if the data is available. 
 
A simplified WHOIS variant is as follows: 
 
w:w1aw 
 
You can also do a name lookup to find a callsign. 
 
n:robert bruninga 
 
Returns is the number of "hits" and up to seven callsigns.  Any more then 
seven will be truncated. 
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[1] WB4APR 
 
Doing name lookups is not always successful as city names and street names 
may also be included in the search. 
 
Brent KH2Z 
 
 
 
ERROR TRAPS 
 
In addition to the new trap, I have added a "Tracer" function which 
will trace the execution of each function and windows callback.  When 
activated and the program abends, it will save the execution stack for 
review. To activate the Tracer, you need to open the Calculator 
window, and enter the following: 
 
Tracer 
 
Ignore the error in the upper calculator window - this is expected. 
 
 
 
APRS+SA AND PSK31svr 
 
PSK31svr by Roger Barker, G4IDE, is an experimental TCP/IP server that 
will talk to APRSPLUS for the purpose of transmitting and receiving 
PSK31 data in the APRS format. 
 
As an experimental program, what you see is what you get, with all 
possible consequences! RTFM! Read the docs! 
 
The program can be found at: 
 
http://www.rochesterny.org/beaconet/ 
 
Set up APRSPLUS for an internet connection but instead of connecting 
to your favorite internet APRS server, comment out all the internet 
servers in the APRSERVE.TXT file and add this one: 
 
localhost:3131 
 
This will provide the connection from APRSPLUS to PSK31svr so that both 
programs can talk to each other. 
 
NB! Make sure that Setup > Program > Add Transmitted Data to Input Buffer 
is NOT checked. If it is it will cause all data originating from your 
system to be sent to PSK31svr, twice, resulting in 2 status beacons, 
position reports, queries, etc. 
 
The purpose of the function is to cause your own data to be decoded 
as if transmitted on RF; i.e. it is always decoded.  It ensures you 
see it as if digipeated, while using APRS+ in the manner for which 
it was designed. 
 
FINI 

HOME 
 © 2002 
Manistique.org 
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